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Despre acest manual

/A AVERTISMENT! Textul evidentiat in aceasta maniera indica faptul ca nerespectarea instructiunilor
poate avea ca rezultat ranirea fizica sau pierderea vietii.

A ATENTIE: Textul evidentiat in aceastd maniera indica faptul ca nerespectarea instructiunilor poate
avea ca rezultat deteriorarea echipamentului sau pierderea de informatii.

Bf NOTA: Textul evidentiat in aceasta maniera furnizeaza informatii suplimentare importante.
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1 Caracteristici de diagnosticare a
computerelor

HP Insight Diagnostics

Bf NOTA: HP Insight Diagnostics este inclus pe CD numai la unele modele de computere.

Utilitarul HP Insight Diagnostics permite vizualizarea informatiilor despre configuratia hardware a
computerului si efectueaza teste de diagnosticare hardware a subsistemelor computerului. Utilitarul
simplifica procesul de identificare, diagnosticare si izolare efectiva a problemelor hardware.

Cand invocati HP Insight Diagnostics, se afiseaza fila Survey (Supraveghere). Aceasta fila afiseaza
configuratia curenta a computerului. Din fila Survey (Supraveghere), exista acces catre mai multe
categorii de informatii despre computer. Celelalte file furnizeaza informatii suplimentare, inclusiv optiuni
pentru testele de diagnosticare si rezultate ale testelor. Informatiile din fiecare ecran al utilitarului se pot
salva ca fisier html si se pot stoca pe o discheta sau pe un dispozitiv USB HP Drive Key.

Utilizati HP Insight Diagnostics pentru a determina daca toate dispozitivele instalate pe computer sunt
recunoscute de sistem gi dacé acestea functioneaza corect. Executarea testelor este optionala, dar este
recomandata dupa instalarea sau conectarea unui dispozitiv nou.

Executati testele, salvati si imprimati rezultatele testelor astfel incat sa aveti disponibile rapoarte
imprimate nainte sa apelati la centrul de asistenta pentru clienti.

B NOTA: Este posibil ca dispozitivele de la alti furnizori sa nu fie detectate de HP Insight Diagnostics.

Accesarea utilitarului HP Insight Diagnostics

Pentru a accesa HP Insight Diagnostics, trebuie s& creati un set de discuri de recuperare, apoi sa
incarcati de pe CD-ul care contine utilitarul. De asemenea, se poate descarca din http://www.hp.com.
Pentru informatii suplimentare, consultati Descarcarea celei mai recente versiuni a utilitarului HP Insight
Diagnostics, la pagina 6.

Bf NOTA: HP Insight Diagnostics este inclus ca parte a setului de discuri de recuperare numai la unele
modele de computere.

Daca deja ati creat un set de discuri de recuperare, incepeti procedura urmatoare de la pasul 4.

1. Faceti clic pe Start > HP Backup and Recovery (Copiere de rezerva si recuperare HP) > HP
Backup and Recovery Manager (Manager HP pentru copiere de rezerva si recuperare), pentru
a deschide Backup and Recovery Wizard (Expert copiere de rezerva si recuperare), apoi faceti clic
pe Next (Urmatorul).

2. Selectati Create a set of recovery discs (Recommended) (Creare set de discuri de recuperare
— Recomandat) si faceti clic pe Next (Urmatorul).

3. Urmati instructiunile din expert pentru a crea un set de discuri de recuperare.
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4. Utilizati Windows Explorer pentru a gasi CD-ul cu directorul compaq\hpdiags in setul de discuri
de recuperare.

5. Intimp ce computerul este pornit, introduceti CD—ul intr—o unitate optica a computerului.
6. Opriti sistemul de operare si computerul.

7. Porniti computerul. Sistemul se va incarca de pe CD.

B NOTA: Daca sistemul nu se incarca de pe CD—-ul din unitatea optica, este posibil sa fie necesar
sa modificati ordinea de incarcare din utilitarul Computer Setup (F10), astfel incat sa se incerce
incarcarea sistemului de pe unitatea optica Thainte de incarcarea de pe unitatea de disc. Pentru
informatii suplimentare, consultati Ghidul programului utilitar Computer Setup (F10).

8. Selectati limba corespunzatoare si faceti clic pe Continue (Continuare).

¥ NOTA: Serecomandd sa acceptati tastatura asociata implicit limbii, daca nu doriti sa testati o
anumita tastatura specifica.

9. In pagina End User License Agreement (Acord de licenta pentru utilizatorul final), faceti clic pe
Agree (De acord) daca sunteti de acord cu termenii acordului. Utilitarul HP Insight Diagnostics se
lanseaza cu afisarea filei Survey (Supraveghere).

Fila Survey (Supraveghere)
Fila Survey (Supraveghere) afiseaza informatii importante despre configuratia sistemului.

n campul View level (Nivel vizualizare), aveti posibilitatea sa selectati vizualizarea tip Summary
(Rezumat) pentru a vizualiza date limitate despre configuratie, sau sa selectati vizualizarea tip
Advanced (Avansat) pentru a vizualiza toate datele din categoria selectata.

in campul Category (Categorie), aveti posibilitatea sa selectati urmatoarele categorii de informatii de
afisat:

All (Toate) — Ofera o lista a tuturor categoriilor de informatii despre computer.
Overview (Prezentare generald) — Ofera o lista a informatiilor generale despre computer.

Architecture (Arhitectura) — Furnizeaza informatii despre BIOS si despre dispozitivele PCI ale
sistemului.

Asset Control (Control active) — Afiseaza numele produsului, numarul de inventar, numarul de serie al
sistemului si informatii despre procesor.

Communication (Comunicare) — Afiseaza informatii despre setarile porturilor paralel (LPT) si serial
(COM), plus informatii despre controlerele USB si de retea.

Graphics (Elemente grafice) — Afiseaza informatii despre controlerul grafic al computerului.

Input Devices (Dispozitive de intrare) — Afiseaza informatii despre tastatura, mouse si alte dispozitive
de intrare conectate la computer.

Memory (Memorie) — Afiseaza informatii despre toatd memoria computerului. Sunt incluse sloturile de
memorie de pe placa de sistem si orice alte module de memorie instalate.

Miscellaneous (Diverse) — Afiseaza informatii despre versiunea HP Insight Diagnostics, informatii
despre memoria de configurare a computerului (CMOS), date despre placa de sistem si date BIOS
despre gestionarea sistemului.

Storage (Stocare) — Afigeaza informatii despre suporturile de stocare conectate la computer. Aceasta
lista include toate discurile fixe, unitatile de discheta si unitatile optice.
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System (Sistem) — Afiseaza informatii despre modelul de computer, procesor, sasiu, BIOS, plus
informatii despre difuzorul intern si despre magistrala PCI.
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Fila Test

Fila Test va permite sa selectati diferite componente ale sistemului pentru a le testa. Aveti, de
asemenea, posibilitatea sa selectati tipul de test si modul de testare.

Aveti posibilitatea s& alegeti unul din trei tipuri de teste:

Quick Test (Test rapid) — Asigura un script predeterminat in care se testeaza cate o parte a fiecarei
componente hardware, fara sa fie necesara interventia utilizatorului nici in modul nesupravegheat,
nici Tn cel interactiv.

Complete Test (Test complet)n— Asigura un script predeterminat in care se testeaza complet
fiecare componenta hardware. In modul interactiv exista mai multe teste disponibile, dar pentru
acestea este necesara interventia utilizatorului.

Custom Test (Test particularizat) — Asigura cea mai mare flexibilitate pentru a controla testarea
unui sistem. Modul Custom Test (Test particularizat) va permite sa selectati exact pentru care
dispozitive, care teste si ce parametri ai testelor se executa.

Pentru fiecare tip de test, aveti posibilitatea sa selectati unul din doua moduri de testare:

Interactive Mode (Modul interactiv) — Asigura control maxim in timpul procesului de testare.
Software-ul de diagnosticare va avea unele solicitari in timpul testelor, la care va fi necesar sa
raspundeti. De asemenea, aveti posibilitatea sa determinati daca testul a reusit sau nu.

Unattended Mode (Mod nesupravegheat) — Nu afiseaza solicitari si nu este necesar sa interveniti.
Daca sunt gasite erori, acestea sunt afisate dupa terminarea testarii.

Pentru a incepe testarea:

1.
2,

Selectati fila Test.

Selectati fila pentru tipul de test pe care doriti sa il executati: Quick (Rapid), Complete (Complet)
sau Custom (Particularizat).

Selectati Test Mode (Mod testare): Interactive (Interactiv) sau Unattended (Nesupravegheat).

Alegeti modul in care doriti sa se execute testul, fie Number of Loops (Numar de cicluri), fie Total
Test Time (Timp total de testare). Daca alegeti ca testul sa se execute pentru un anumit numar
de cicluri, introduceti numarul de cicluri de efectuat. Daca doriti un test de diagnosticare pentru o
anumita perioada de timp, introduceti perioada de timp in minute.

Daca se executa un test rapid (Quick Test ) sau un test complet (Complete Test), selectati
dispozitivul care va fi testat din lista verticala. Daca se executa un test particularizat (Custom Test),
faceti clic pe butonul Expand (Extindere) si selectati dispozitivul care va fi testat sau faceti clic pe
butonul Check All (Verificare toate) pentru a selecta toate dispozitivele.

Faceti clic pe butonul Begin Testing (incepere testare) in coltul din dreapta-jos al ecranului pentru
a incepe testarea. Fila Status (Stare), care va permite sa monitorizati evolutia testului, se afiseaza
automat in timpul procesului de testare. Cand testul s-a terminat, fila Status (Stare) afiseaza daca
dispozitivul a trecut testul sau nu.

Daca s-au gasit erori, mergeti la fila Log (Jurnal) si faceti clic pe Error Log (Jurnal erori) pentru a
se afisa informatii mai detaliate si actiunile recomandate.

Fila Status (Stare)

Fila Status (Stare) afiseaza starea testelor selectate. Se afiseaza, de asemenea, tipul de test executat
(Quick (Rapid), Complete (Complet) sau Custom (Particularizat)). Bara de progres principala afiseaza
procentul in care s-a finalizat setul de teste curent. In timpul desfasurérii testelor, este afisat un buton
Cancel Testing (Revocare testare) pentru a fi utilizat in cazul in care doriti sa revocati testarea.
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Dupa finalizarea testarii, butonul Cancel Testing (Revocare testare) este inlocuit cu butonul Retest
(Testare iar). Butonul Retest (Testare iar) va efectua din nou ultimul set de teste executate. Astfel aveti
posibilitatea s& efectuati inca o data setul de teste, fara a introduce din nou date in fila Test.

Fila Status (Stare) mai afiseaza:

e Dispozitivul testat

e  Starea testarii (in executie, finalizare reusita sau nereusita) pentru fiecare dispozitiv testat
e Evolutia completa a testarii pentru toate dispozitivele testate

e  Evolutia testarii pentru fiecare dispozitiv testat

e Timpii consumati pentru testarea fiecarui dispozitiv in parte

Fila Log (Jurnal)
Fila Log (Jurnal) contine o fila Test Log (Jurnal teste) si o fila Error Log (Jurnal erori).

Test Log (Jurnal teste) afiseaza toate testele efectuate, numarul de executari, numarul de nereusite si
perioada cat a durat fiecare test pana la finalizare. Butonul Clear Test Log (Golire jurnal teste) va goli
de continut Test Log (Jurnal teste).

Error Log (Jurnal erori) afiseaza testele pentru dispozitivele care nu au trecut testele de diagnosticare
si include urmatoarele coloane de informatii.

e Sectiunea Device (Dispozitiv) afiseaza dispozitivele testate.
e Sectiunea Test afigseaza tipul de testare executat.
e Sectiunea Description (Descriere) descrie eroarea gasita de testul de diagnosticare.

e Recommended Repair (Reparatie recomandata) va ofera o actiune recomandata care trebuie
efectuata pentru a repara hardware-ul defect.

e Failed Count (Numar nereusite) reprezinta numarul de nereusite la testarea dispozitivului.

e Error Code (Cod eroare) furnizeaza un cod numeric al defectiunii. Codurile de eroare sunt definite
in fila Help (Ajutor).

Butonul Clear Error Log (Golire jurnal erori) va goli de continut Error Log (Jurnal erori).

Fila Help (Ajutor)

Fila Help (Ajutor) contine o fila HP Insight Diagnostics, o fila Error Codes (Coduri eroare) si o fila
Test Components (Testare componente).

Fila HP Insight Diagnostics contine subiecte de ajutor si include caracteristici de cautare si de index.

Fila Error Codes (Coduri eroare) furnizeaza o descriere pentru fiecare cod numeric de eroare care
poate sa apara in fila Error Log (Jurnal erori) situata pe fila Log (Jurnal). Fiecare cod are un mesaj de
eroare corespondent Message (Mesaj) si o actiune Recommended Repair (Reparatie recomandata)
care va ajuta sa rezolvati problema. Pentru a gasi rapid o descriere a unui cod de eroare, introduceti
codul in caseta din partea superioara a filei si faceti clic pe butonul Find Error Codes (Gasire coduri
eroare).

Fila Test Components (Testare componente) afiseaza informatii limitate despre testele in executie.

Salvarea si imprimarea informatiilor din HP Insight Diagnostics

Aveti posibilitatea sa salvati informatiile afisate in filele Survey (Supraveghere) si Log (Jurnal) din HP
Insight Diagnostics pe o discheta sau pe un dispozitiv USB 2.0 HP Drive Key (de 64 MO sau superior).
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Salvarea nu se poate face pe unitatea de disc. Sistemul va crea automat un figier html cu aspect
asemanator cu informatiile afisate pe ecran.

1.

5.

Introduceti o discheta sau un dispozitiv USB 2.0 HP Drive Key (capacitatea trebuie sa fie de 64
MO sau superioara). Dispozitivele USB 1.0 Drive Key nu sunt acceptate.

Faceti clic pe Save (Salvare) in coltul din dreapta-jos al ecranului.

Selectati Save to the floppy (Salvare pe discheta) sau Save to USB key (Salvare pe dispozitiv
USB Drive Key).

Introduceti un nume de figier in caseta File Name (Nume figier) si faceti clic pe butonul Save
(Salvare). Pe discheta sau pe dispozitivul USB HP Drive Key introduse se va salva un figier html.

NOTA: Nu extrageti discheta sau dispozitivul USB Drive Key pana cand nu vedeti un mesaj care
confirma ca fisierul html a fost inregistrat pe suportul respectiv.

Imprimati informatiile de pe dispozitivul de stocare utilizat pentru salvarea lor.

E¥ NOTA: Pentru aiesi din HP Insight Diagnostics, faceti clic pe butonul Exit Diagnostics (lesire
diagnosticare) in coltul din stanga-jos al ecranului, apoi scoateti CD-ul din unitatea optica.

Descarcarea celei mai recente versiuni a utilitarului HP Insight Diagnostics
1.

2
3
4.
5
6
7

8.

Accesati http://www.hp.com.

Faceti clic pe legatura Software & Driver Downloads (Descarcari de software si drivere).
Introduceti numarul de produs (de exemplu dc7700) in caseta text si apasati tasta Enter.
Selectati modelul specific de computer.

Selectati sistemul de operare.

Faceti clic pe legatura Diagnostic (Diagnosticare).

Faceti clic pe HP Insight Diagnostics Offline Edition.

Selectati o limba si faceti clic pe Download (Descarcare).

Bf NOTA: Rezultatul descarcarii contine instructiuni despre cum sa creati CD-ul de incarcare.

Protejarea software-ului

Pentru a proteja software-ul impotriva pierderii sau deteriorarii, trebuie pastrati o copie de rezerva pentru
intreg sistemul de operare, pentru aplicatii si pentru figierele legate de acestea, care se afla pe unitatea
de disc. Pentru instructiuni despre modul de realizare a copiilor de rezerva pentru fisierele de date,
consultati documentatia sistemului de operare sau a utilitarului pentru copiere de rezerva.

HP Backup and Recovery Manager (Manager HP pentru
copiere de rezerva si recuperare)

HP Backup and Recovery Manager (Manager HP pentru copiere de rezerva si recuperare) este o
aplicatie multilaterala, usor de utilizat, care va permite sa efectuati copierea de rezerva si recuperarea
continutului unitatii de disc a PC-ului. Aplicatia lucreaza in sistemul de operare Windows pentru a crea
copii de rezerva ale sistemului Windows, ale tuturor aplicatiilor si figierelor de date. Copiile de rezerva
pot fi programate sa se realizeze automat la intervale de timp bine stabilite sau pot fi initiate manual.
Fisierele importante pot fi arhivate separat de copiile de rezerva curente.
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HP Backup and Recovery Manager (Manager HP pentru copiere de rezerva si recuperare) este o
aplicatie preinstalata pe partitia de recuperare a unitatii de disc, care va permite sa:

e creati puncte de recuperare pentru a face o copie de rezerva cumulativa a intregului sistem
e faceti o copie de rezerva a intregului sistem intr-o singura arhiva
e faceti o copie de rezerva a figierelor si a folderelor individuale

Copiile de rezerva ale punctelor de recuperare si ale fisierelor se pot face pe discul CD sau DVD, in
timp ce toate copiile de rezerva pot fi realizate in retea sau pe unitatile de disc secundare.

HP va recomanda in mod special sa creati imediat un set de discuri de recuperare, inainte sa utilizati
computerul i s& programati cu regularitate copii de rezerva realizate automat prin puncte de recuperare.

Pentru a crea setul de discuri de recuperare:

1. Faceti clic pe Start > HP Backup and Recovery (Copiere de rezerva si recuperare HP) > HP
Backup and Recovery Manager (Manager HP pentru copiere de rezerva si recuperare), pentru
a deschide Backup and Recovery Wizard (Expert copiere de rezerva si recuperare), apoi faceti clic
pe Next (Urmatorul).

2. Selectati Create a set of recovery discs (Recommended) (Creare set de discuri de recuperare
— Recomandat) si faceti clic pe Next (Urmatorul).

3. Urmati instructiunile din expert.

HP Backup and Recovery Manager (Manager HP pentru copiere de rezerva si recuperare) furnizeaza
doua metode principale de recuperare. Prima, pentru recuperarea fisierelor si a folderelor, se utilizeaza
in Windows. Cea de-a doua, de recuperare a PC-ului, necesita o reincarcare a sistemului din partitia
de recuperare sau din setul de discuri de recuperare. Pentru a reincarca din partitia de recuperare,
apasati tasta F11 la pornire atunci cand vedeti mesajul ,Press F11 for Emergency Recovery” (Apasati
tasta F11 pentru recuperarea de urgenta).

Pentru informatii suplimentare despre utilizarea aplicatiei HP Backup and Recovery Manager (Manager
HP pentru copiere de rezerva si recuperare), consultati HP Backup and Recovery Manager User
Guide (Ghidul utilizatorului managerului HP pentru copiere de rezerva si recuperare) selectand Start >
HP Backup and Recovery (Copiere de rezerva si recuperare HP) > HP Backup and Recovery
Manager Manual (Manual Manager HP pentru copiere de rezerva si recuperare).

NOTA: Puteti s& comandati un set de discuri de recuperare de la HP apeland la centrul de asistenta
HP. Accesati urmatorul site Web, selectati tara/regiunea dvs. si faceti clic pe legatura Technical
support after you buy (Asistenta tehnica dupa cumparare) de sub antetul Call HP (Apelare HP) pentru
a obtine numarul de telefon al centrului de asistenta pentru tara/regiunea dvs.

http://welcome.hp.com/country/us/en/wwcontact_us.html
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2 Depanare fara diagnosticare

Acest capitol furnizeaza informatii despre modul de identificare si de corectare a problemelor minore,
cum ar fi probleme legate de unitatea de discheta, unitatea de disc, unitatea optica, grafica, audio,
memorie si software. Daca apar probleme in functionarea computerului, consultati tabelele din acest
capitol pentru cauzele probabile si solutiile recomandate.

Bf NOTA: Pentru informatii despre mesajele specifice de eroare care pot s& apara pe ecran in timpul
testarii automate la pornire (Power-On Self-Test - POST), consultati Anexa A, Mesaje de eroare POST,

la pagina 51.

Siguranta si confort

/A AVERTISMENT! Daca utilizati computerul incorect sau daca nu reusiti sa asigurati un mediu de lucru
sigur si confortabil, pot surveni defectiuni sau pericol de ranire grava. Pentru informatii suplimentare
despre alegerea unui spatiu de lucru si crearea unui mediu de lucru sigur si confortabil, consultati Safety
& Comfort Guide (Ghid pentru siguranta si confort) pe site-ul cu adresa http://www.hp.com/ergo. Acest
echipament a fost testat si s-a constatat ca se incadreaza in limitele prevazute in partea a 15-a a
normelor FCC aferente clasei B pentru dispozitive digitale. Pentru informatii suplimentare, consultati
Safety & Regulatory Information (Informatii despre norme si despre siguranta).

inainte de a apela asistenta tehnica

Daca aveti probleme cu computerul, pentru a identifica exact problema Tnainte de a apela la asistenta
tehnica, Tncercati solutia corespunzatoare dintre cele de mai jos.

e  Executati utilitarul de diagnosticare. Pentru mai multe informatii, consultati Capitolul 1,
Caracteristici de diagnosticare a computerelor, la pagina 1.

e  Executati testul Drive Protection System (DPS) din programul Computer Setup. Pentru informatii
suplimentare, consultati Computer Setup (F10) Utility Guide (Ghidul programului utilitar Computer
Setup (F10)).

e Verificati LED-ul pentru alimentare de pe panoul frontal al computerului pentru a vedea daca
lumineaza rosu intermitent. Indicatoarele luminoase care clipesc reprezinta coduri de eroare care
va ajuta sa diagnosticati problema. Pentru mai multe informatii, consultati Anexa A, Mesaje de
eroare POST, la pagina 51.

e Daca pe ecran nu apare nimic, conectati monitorul la un alt port video al computerului, daca este
disponibil. Ca varianta, tnlocuiti monitorul cu un monitor care stiti ca functioneaza corect.

e Daca lucrati in retea, conectati un alt computer gi un alt cablu la conexiunea de retea. Este posibil
sa aveti o problema cu conectorul sau cu cablul de retea.

e Daca ati adaugat recent hardware nou, scoateti hardware-ul si verificati daca computerul
functioneaza corect.

e Daca ati instalat recent software nou, dezinstalati software-ul si verificati daca computerul
functioneaza corect.
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e  Porniti computerul in Safe Mode (Mod protejat) pentru a vedea daca porneste fara sa incarce toate
driverele. Cand se incarca sistemul de operare, utilizati ,Last Known Configuration” (Ultima
configuratie cunoscuta).

e Consultati asistenta tehnica online mai cuprinzatoare, la adresa http://www.hp.com/support.

e  Consultati urméatoarea sectiune Indicii utile, la pagina 9 din acest ghid.

Pentru a va asista la rezolvarea interactiva a problemelor, programul HP Instant Support Professional
Edition va furnizeaza solutii de diagnosticare automata. Daca este necesar sa contactati asistenta HP,
utilizati caracteristica de chat interactiv a programului HP Instant Support Professional Edition.
Programul HP Instant Support Professional Edition poate fi accesat la adresa: http://www.hp.com/go/
ispe.

Pentru cele mai recente informatii online despre asistenta, software si drivere, notificari in timp real si
despre comunitatea internationala de experti si utilizatori HP, accesati centrul de asistenta Business
Support Center (BSC) la adresa http://www.hp.com/go/bizsupport.

Daca devine necesar sa apelati serviciul de asistenta tehnica, fiti pregatit sa faceti urmatoarele pentru
a avea siguranta ca apelul dvs. va fi tratat corespunzator:

e Inainte de apel, agsezati-va in fata computerului.

e Notati numarul de serie al computerului, numarul de identificare a produsului si numarul de serie
al monitorului.

e  Alocati timp pentru depanarea problemei impreuna cu un tehnician de service.
e  Scoateti orice hardware adaugat recent in sistem.
e Eliminati software-ul instalat recent.

e Restaurati sistemul de pe setul de discuri de recuperare pe care le-ati creat sau restaurati sistemul
la configuratia din fabrica utilizand HP Backup and Recovery Manager (Manager copiere de
rezerva si recuperare HP).

ATENTIE: Prin restaurarea sistemului se vor sterge toate datele de pe unitatea de disc. Asigurati-va
ca ati facut copii de rezerva ale tuturor figierelor de date inainte de procesul de restaurare.

NOTA: Pentru informatii despre vanzari si pentru upgrade-uri ale certificatelor de garantie (Care
Pack), apelati la furnizorul sau distribuitorul local de servicii autorizat.

Indicii utile

ROWW

Daca intdmpinati probleme cu computerul, cu monitorul sau cu software-ul, inainte de a efectua alte
operatiuni, consultati lista urmatoare de sugestii generale:

e Verificati daca computerul si monitorul sunt conectate la o priza electrica.

e Verificati daca comutatorul de selectare a tensiunii (la anumite modele) este setat la tensiunea
corespunzatoare tarii/regiunii in care va aflati (115V or 230V).

e Verificati daca computerul este pornit si daca indicatorul luminos verde este aprins.
e Verificati daca monitorul este pornit si daca indicatorul luminos verde al acestuia este aprins.

e Verificati LED-ul pentru alimentare de pe panoul frontal al computerului pentru a vedea daca
lumineaza rosu intermitent. Indicatoarele luminoase care clipesc reprezinta coduri de eroare care
va ajuta sa diagnosticati problema. Pentru mai multe informatii, consultati Anexa A, Mesaje de
eroare POST, la pagina 51.

e Daca monitorul este intunecat, activati controalele pentru luminozitate si contrast ale acestuia.

Indicii utile 9
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e Tineti apasata orice tasta. Daca sistemul emite un semnal sonor, inseamna ca tastatura
functioneaza corect.

e Aveti grija ca nici o conexiune prin cablu sa nu fie slabita sau incorecta.

e Porniti computerul, apaséand pe orice tastd sau apasand butonul de alimentare. Daca sistemul
raméane in modul de suspendare, opriti computerul tindnd apéasat butonul de alimentare cel putin
patru secunde, apoi apéasati din nou butonul de alimentare pentru a reporni computerul. Daca
sistemul nu se opreste, deconectati cablul de alimentare, agteptati cateva secunde, apoi conectati-
[ la loc. Daca in programul Computer Setup este setata optiunea de pornire automata in caz de
intrerupere a alimentarii, computerul pornesgte din nou automat. Daca nu pornegte din nou, apasati
butonul de alimentare pentru a porni computerul.

e Dupa ce instalati o placa de extensie sau o componenta optionala care nu este plug-and-play,
configurati din nou computerul. Pentru instructiuni, consultati Rezolvarea problemelor de instalare
a hardware-lui, la pagina 34.

e \Verificati daca au fost instalate toate driverele necesare pentru dispozitive. De exemplu, daca
utilizati o imprimanta, este necesar un driver pentru modelul respectiv de imprimanta.

e  Scoateti toate suporturile incarcabile (discheta, CD sau dispozitiv USB) din sistem inainte de a-l
porni.

e Daca ati instalat un alt sistem de operare decét cel instalat din fabrica, verificati daca acesta este
acceptat de sistem.

e Daca in sistem sunt instalate mai multe surse video (incorporate sau adaptoare PCI sau PCI-
Express) - surse video incorporate exista numai la anumite modele - si un singur monitor, monitorul
trebuie sa fie conectat in conectorul pentru monitor al sursei selectate ca adaptor principal VGA.
Tn timpul tncarcarii sistemului, celelalte conectoare pentru monitor sunt dezactivate, deci monitorul
nu va functiona daca este conectat la aceste porturi. Selectati care sursa VGA va fi cea principala,
din programul Computer Setup.

A ATENTIE: Cand computerul este conectat la o sursa de curent alternativ, la placa de sistem se aplica
intotdeauna o tensiune. Inainte de a deschide computerul, pentru a impiedica orice deteriorare a placii
de sistem, trebuie sa deconectati cablul de alimentare de la sursa de alimentare.
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Rezolvarea problemelor generale

Aveti posibilitatea sa rezolvati usor problemele generale descrise in aceasta sectiune. Daca o problema
persista si nu reusiti sa o rezolvati singur sau nu aveti conditii pentru efectuarea operatiunii, contactati
un distribuitor sau un revanzator autorizat.

/A AVERTISMENT! Cand computerul este conectat la o sursa de curent alternativ, la placa de sistem se
aplica intotdeauna o tensiune. Pentru a reduce riscul de ranire din cauza socurilor electrice si/sau a
suprafetelor fierbinti, decuplati cablul de alimentare de la priza si asteptati pana cand componentele
interne ale sistemului se racesc, inainte de a le atinge.

Tabelul 2-1 Rezolvarea problemelor generale

Computerul este aparent blocat si nu se opreste cand se apasa butonul de alimentare.

Cauza Solutie
Controlul prin software al comutatorului de alimentare nu 1. Tineti apasat butonul de alimentare cel putin patru
functioneaza. secunde, pana cand computerul se opreste.

2. Deconectati cablul de alimentare de la priza electrica.

Computerul nu reactioneaza la tastatura sau mouse-ul USB.

Cauza Solutie

Computerul este in modul oprire temporara. Apasati butonul de alimentare sau apasati orice tasta pentru a
iesi din modul oprire temporara.

ATENTIE: Cand incercati s& iesiti din modul oprire
temporara, nu tineti apasat butonul de alimentare mai mult de
patru secunde. In caz contrar, computerul se va opri si orice
date care nu au fost salvate se vor pierde.

Sistemul s-a blocat. Reporniti computerul.

Computerul afiseaza incorect data si ora.

Cauza Solutie

Este posibil sa fie necesara inlocuirea bateriei RTC (real-time Mai intai, resetati data si ora din Control Panel (Panou de

clock — ceas in timp real). control) — pentru a actualiza ceasul in timp real se poate utiliza
. si programul Computer Setup. Daca problema persista,

NOTA: Conectarea computerului la o priza de c.a. inlocuiti bateria RTC. Pentru instructiuni despre instalarea unei

prelungeste viata bateriei RTC. baterii noi, consultati Hardware Reference Guide (Ghid de

referintd hardware) sau contactati un dealer sau un revanzator
autorizat pentru inlocuirea bateriei RTC.

Cursorul nu se migca la utilizarea tastelor sageti de pe tastatura.

Cauza Solutie

Este posibil ca tasta Num Lock sa fie apasata. Apasati tasta Num Lock. Indicatorul luminos Num Lock nu
trebuie sa fie aprins cand utilizati tastele sageti. Tasta Num
Lock se poate dezactiva (sau activa) din programul Computer
Setup.

ROWW Rezolvarea problemelor generale 11



Tabelul 2-1 Rezolvarea problemelor generale (Continuare)

Nu exista sunet sau volumul sunetului este prea scazut.

Cauza

Solutie

Este posibil ca volumul sistemului sa fie setat pe o valoare prea
mica sau sa fie anulat.

1. Verificati setarile F10 BIOS pentru a va asigura ca
difuzorul intern al sistemului nu are volumul anulat
(aceasta setare nu afecteaza difuzoarele externe).

2. Verificati daca difuzoarele externe sunt conectate si
alimentate corect si daca este setat corect controlul
pentru volumul difuzoarelor.

3.  Utilizati controlul pentru volumul sistemului, disponibil in
sistemul de operare, pentru a verifica daca difuzoarele nu
au volumul anulat sau pentru a mari volumul.

Nu se poate extrage capacul sau panoul de acces de la computer.

Cauza

Solutie

Smart Cover Lock (Zavor capac inteligent), prevazut pe unele
computere, este blocat.

Deblocati Smart Cover Lock (Zavor capac inteligent) utilizand
programul Computer Setup.

Cheia Smart Cover FailSafe este un dispozitiv HP utilizat
pentru a dezactiva manual Smart Cover Lock. Veti avea nevoie
de cheia FailSafe in cazul in care ati uitat parola, la
intreruperea alimentarii sau la defectarea computerului.
Comandati PN 166527-001 pentru cheia fixa sau PN
166527-002 pentru cheia adaptata pentru cap de surubelnita.

Sistemul functioneaza cu performante reduse.

Cauza

Solutie

Procesorul este incins.

1. Asigurati-va ca fluxul de aer spre computer nu este
blocat. Lasati un loc liber de 10,2 cm (4 inch) in toate
partile cu aerisire ale computerului, inclusiv deasupra
monitorului, pentru a permite circulatia curentului de aer
necesar

2. \Verificati daca ventilatoarele sunt conectate si
functioneaza corect (unele ventilatoare functioneaza

numai cand este necesar).

3. Verificati daca radiatorul procesorului este instalat corect.

Unitatea de disc este plina.

Transferati date de pe unitatea de disc pentru a crea mai mult
spatiu.

Memorie insuficienta.

Adaugati memorie suplimentara.

Unitatea de disc este fragmentata.

Defragmentati unitatea de disc.

Programul accesat anterior nu a eliberat memoria rezervata
pentru a fi utilizata din nou de sistem.

Reporniti computerul.

Exista un virus pe unitatea de disc.

Executati programul de protectie impotriva virusilor.

Se executa prea multe aplicatii.

1. Inchideti aplicatiile care nu sunt necesare pentru a elibera
memorie.

2. Adaugati memorie suplimentara. Unele aplicatii se
executa in fundal si pot fi inchise facand clic cu butonul
din dreapta al mouse—ului pe pictogramele lor
corespunzatoare din tava de activitati. Pentru a impiedica
lansarea la pornire a acestor aplicatii, mergeti la Start >
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Tabelul 2-1 Rezolvarea problemelor generale (Continuare)

Sistemul functioneaza cu performante reduse.

Cauza

Solutie

Run (Executare) (Windows XP) sau Start >
Accessories (Accesorii) > Run (Executare) (Windows
Vista) si introduceti msconfig. Pe fila Startup din
System Configuration Utility (Utilitar configurare sistem),
debifati aplicatiile care nu doriti sa se lanseze automat.

Unele aplicatii software, mai ales jocurile, solicita foarte mult
subsistemul grafic

2

3.

Micgorati rezolutia ecranului pentru aplicatia curenta sau
consultati documentatia livrata impreuna cu aplicatia
pentru sugestii despre cum sa imbunatatiti performanta
ajustand parametrii aplicatiei.

Adaugati memorie suplimentara.

Faceti upgrade la solutia grafica.

Cauza necunoscuta.

Reporniti computerul.

Computerul s-a deconectat automat si LED-ul de alimentare clipeste de doua ori in culoare rosie, o data pe secunda,
dupa care urmeaza o pauza de doua secunde si computerul emite de doua ori un semnal sonor. (Semnalele sonore
se opresc dupa a cincea repetare, dar LED-urile continua sa clipeasca).

Cauza

Solutie

Protectia termica a procesorului este activata:
Un ventilator este blocat sau nu se roteste.
SAU

Radiatorul nu este atasat corect la procesor.

1.

Verificati daca orificiile de ventilatie ale computerului nu
sunt blocate si daca ventilatorul de racire a procesorului
functioneaza.

Deschideti capacul, apasati butonul de alimentare si
verificati daca ventilatorul procesorului se roteste. Daca
ventilatorul procesorului nu se roteste, verificati modul de
conectare a cablului ventilatorului la placa de sistem.

Daca ventilatorul este conectat si pozitionat corect, dar
nu se roteste, atunci inlocuiti ansamblul radiator/
ventilator.

Contactati un distribuitor sau furnizor de servicii autorizat.

Sistemul nu se alimenteaza si LED-urile de pe partea frontala a computerului nu clipesc.

Cauza

Solutie

Sistemul nu se poate alimenta.

Tineti apasat butonul de alimentare mai putin de patru
secunde. Daca LED-ul unitatii de disc se aprinde verde:

1.

SAU

Verificati daca selectorul de tensiune, amplasat la
anumite modele in partea din spate a sursei de
alimentare, este setat la tensiunea corespunzatoare.
Setarea corecta a tensiunii depinde de tara/regiunea in
care va aflati.

Scoateti pe rand toate placile de extensie, pana cand se
aprinde indicatorul luminos 5V_aux de pe placa de
sistem.

Tnlocuiti placa de sistem.
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Tabelul 2-1 Rezolvarea problemelor generale (Continuare)

Sistemul nu se alimenteaza si LED-urile de pe partea frontala a computerului nu clipesc.

Cauza

Solutie

Tineti apasat butonul de alimentare mai putin de patru
secunde. Daca LED-ul unitatii de disc nu se aprinde verde:

1.

Verificati dacé unitatea este conectata la o priza de c.a.
functionala.

Deschideti capacul si verificati daca firele butonului de
alimentare sunt conectate corect la placa de sistem.

Verificati daca ambele cabluri ale sursei de alimentare
sunt conectate corect la placa de sistem.

Verificati daca indicatorul luminos 5V_aux de pe placa de
sistem este aprins. Daca este aprins, nlocuiti firele

butonului de alimentare.

Daca indicatorul luminos 5V_aux de pe placa de sistem
nu este aprins, inlocuiti sursa de alimentare.

Tnlocuiti placa de sistem.
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Rezolvarea problemelor legate de alimentare

Cauzele si solutiile uzuale pentru problemele legate de alimentare sunt listate in tabelul urmator.

Tabelul 2-2 Rezolvarea problemelor legate de alimentare

Sursa de alimentare se opreste intermitent.

Cauza Solutie

Comutatorul de selectare a tensiunii, amplasat (la unele Selectati tensiunea de c.a. corespunzatoare utilizand
modele) in partea din spate a sasiului computerului, nu este  comutatorul selectiv.
comutat pe tensiunea de linie corecta (115 V sau 230 V).

Sursa de alimentare nu porneste din cauza unei defectiuni Contactati un furnizor de servicii autorizat pentru inlocuirea
interne proprii. sursei de alimentare.

Computerul s-a deconectat automat si LED-ul de alimentare clipeste de doua ori in culoare rosie, o data pe secunda,
dupa care urmeaza o pauza de doua secunde si computerul emite de doua ori un semnal sonor. (Semnalele sonore
se opresc dupa a cincea repetare, dar LED-urile continua sa clipeasca.)

Cauza Solutie
Protectia termica a procesorului este activata: 1. Verificati daca orificiile de ventilatie ale computerului nu
sunt blocate si daca ventilatorul de racire a procesorului
Un ventilator este blocat sau nu se roteste. functioneaza.
SAU 2. Deschideti capacul, apasati butonul de alimentare si
) verificati daca ventilatorul procesorului se roteste. Daca
Radiatorul nu este atagat corect la procesor. ventilatorul procesorului nu se roteste, verificati modul de

conectare a cablului ventilatorului la placa de sistem.

3. Daca ventilatorul este conectat si pozitionat corect, dar
nu se roteste, atunci inlocuiti ansamblul radiator/
ventilator.

4. Contactati un distribuitor sau furnizor de servicii autorizat.

LED-ul de alimentare clipeste de patru ori in culoare rosie, o data pe secunda, dupa care urmeaza o pauza de doua
secunde si computerul emite de patru ori un semnal sonor. (Semnalele sonore se opresc dupa a cincea repetare, dar
LED-urile continua sa clipeasca.)

Cauza Solutie
Defectiune la alimentare (sursa de alimentare este 1. Verificati daca selectorul de tensiune, amplasat (la
supraincarcata). anumite modele) in partea din spate a sursei de

alimentare, este setat la tensiunea corespunzatoare.
Setarea corecta a tensiunii depinde de tara/regiunea in
care va aflati.

2. Deschideti capacul si verificati daca la cablul multifilar al
sursei de alimentare firul 4 sau 6 este pozitionat in
conectorul de pe placa de sistem.

3. Verificati daca problema este cauzata de un dispozitiv
prin indepartarea TUTUROR dispozitivelor atagate (cum
ar fi unitati optice, de disc sau de discheta si placi de
extensie). Porniti sistemul. Daca sistemul intra in
procedura POST, atunci opriti-l si introduceti pe rand cate
un dispozitiv, repetédnd aceasta procedura pana la
aparitia defectiunii. Inlocuiti dispozitivul care cauzeaza
defectiunea. Continuati sa adaugati pe rand dispozitivele
pentru a va asigura de functionarea lor corecta.
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Tabelul 2-2 Rezolvarea problemelor legate de alimentare (Continuare)

LED-ul de alimentare clipeste de patru ori in culoare rosie, o data pe secunda, dupa care urmeaza o pauza de doua
secunde si computerul emite de patru ori un semnal sonor. (Semnalele sonore se opresc dupa a cincea repetare, dar
LED-urile continua sa clipeasca.)

Cauza Solutie

4. Inlocuiti sursa de alimentare.

5. nlocuiti placa de sistem.
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Rezolvarea problemelor legate de dischete

Cauzele si solutiile uzuale pentru problemele legate de dischete sunt listate in tabelul urmator.

Ef NOTA: Cand adaugati sau eliminati hardware, precum o unitate suplimentara de discheta, este posibil
sa fie necesara reconfigurarea computerului. Pentru instructiuni, consultati Rezolvarea problemelor de
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instalare a hardware-lui, la pagina 34.

Tabelul 2-3 Rezolvarea problemelor legate de dischete

Indicatorul luminos aferent unitatii de discheta ramane aprins.

Cauza

Solutie

Discheta este deteriorata.

Tn Microsoft Windows XP, faceti clic cu butonul din dreapta al
mouse-ului pe Start, faceti clic pe Explore (Explorare) si
selectati o unitate. Selectati File > Properties > Tools (Fisier-
Proprietati-Instrumente). Sub Error-checking (Verificare
eroare) faceti clic pe Check Now (Verificare acum).

n Microsoft Windows Vista, faceti clic cu butonul din dreapta
al mouse-—ului pe Start, faceti clic pe Explore (Explorare) si
faceti clic cu butonul din dreapta al mouse—ului pe o unitate.
Selectati Properties (Proprietéti), apoi selectati fila Tools
(Instrumente). Sub Error—checking (Verificare eroare) faceti
clic pe Check Now (Verificare acum).

Discheta nu este introdusa corect.

Scoateti si introduceti din nou discheta.

Cablul unitatii nu este conectat corect.

Reconectati cablul unitatii. Verificati daca toti cei patru pini ai
cablului de alimentare a unitatii de dischet& sunt conectati la
unitate.

Unitatea nu a fost gasita.

Cauza

Solutie

Cablul este slabit.

Repozitionati cablurile unitatii de discheta si cele de alimentare
aferente.

Unitatea amovibila nu este pozitionata corect.

Repozitionati unitatea.

Dispozitivul a fost ascuns in programul Computer Setup.

Executati utilitarul Computer Setup si asigurati—va ca Device
Available (Dispozitiv disponibil) este selectat pentru Legacy
Diskette (Discheta) din Security (Securitate) > Device
Security (Securitate dispozitiv).

Unitatea de discheta nu poate sa scrie pe o discheta.

Cauza

Solutie

Discheta nu este formatata.

Formatati discheta.
1. Din Windows Explorer selectati unitatea de disc (A).

2. Faceti clic cu butonul din dreapta al mouse-ului pe litera
unitatii si selectati Format (Formatare).

3.  Selectati optiunile dorite si faceti clic pe Start pentru a
incepe formatarea dischetei.

Discheta este protejata la scriere.

Utilizati o alta discheta sau eliminati protectia la scriere.

Scrierea nu se realizeaza pe unitatea corespunzatoare.

Verificati litera aferenta unitatii din descrierea caii.
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Tabelul 2-3 Rezolvarea problemelor legate de dischete (Continuare)

Unitatea de discheta nu poate sa scrie pe o discheta.

Cauza

Solutie

Spatiu insuficient pe discheta.

1. Utilizati alta discheta.

2. Stergeti de pe discheta fisierele care nu va sunt de folos.

Scrierile pe vechile dischete sunt dezactivate in Computer
Setup.

Deschideti programul Computer Setup si activati Legacy
Diskette Write (Scriere pe vechile dischete) in Storage >
Storage Options (Stocare-Optiuni stocare).

Discheta este deteriorata.

Tnlocuiti discheta deteriorata.

Discheta nu se poate formata.

Cauza

Solutie

S-a raportat un tip de suport nevalid.

Atunci cand formatati un disc in MS-DOS, este necesar sa
specificati capacitatea dischetei. De exemplu, pentru a formata
o discheta de 1.44-MO, introduceti urmatoarea comanda la
promptul MS-DOS:

FORMAT A: /F:1440

Este posibil ca discul sa fie protejat la scriere.

Deschideti dispozitivul de blocare de pe discheta.

Scrierile pe vechile dischete sunt dezactivate in Computer
Setup.

Deschideti programul Computer Setup si activati Legacy
Diskette Write (Scriere pe vechile dischete) in Storage >
Storage Options (Stocare-Optiuni stocare).

A survenit o problema la o tranzactie pe disc.

Cauza

Solutie

Structura directoarelor este necorespunzatoare sau exista o
problema cu un figier.

n Microsoft Windows XP, faceti clic cu butonul din dreapta al
mouse—ului pe Start, faceti clic pe Explore (Explorare) si
selectati o unitate. Selectati File (Fisier) > Properties
(Proprietati) > Tools (Instrumente). Sub Error—checking
(Verificare eroare), faceti clic pe Check Now (Verificare
acum).

Tn Microsoft Windows Vista, faceti clic cu butonul din dreapta
al mouse—ului pe Start, faceti clic pe Explore (Explorare) si
faceti clic cu butonul din dreapta al mouse—ului pe o unitate.
Selectati Properties (Proprietati), apoi selectati fila Tools
(Instrumente). Sub Error—checking (Verificare eroare) faceti
clic pe Check Now (Verificare acum).

Unitatea de discheta nu poate sa citeasca o discheta.

Cauza

Solutie

Este posibil sa utilizati un tip de discheta necorespunzator
pentru tipul de unitate.

Verificati tipul unit&tii curente si utilizati tipul de discheta
corespunzator.

Este posibil sa cititi un tip gresit de unitate.

Verificati litera aferenta unit&tii din descrierea caii.

Discheta este deteriorata.

Tnlocuiti discheta cu una noua.
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Tabelul 2-3 Rezolvarea problemelor legate de dischete (Continuare)

Se afigeaza mesajul “Invalid system disk” (Disc de sistem nevalid).

Cauza

Solutie

A fost introdusa in unitate o discheta care nu contine fisierele
de sistem necesare pentru pornirea computerului.

Cand activitatea unitatii se opreste, scoateti discheta si apasati
pe Spacebar. Computerul trebuie sa porneasca.

A survenit o eroare de discheta.

Porniti din nou computerul apasand pe butonul de alimentare.

Sistemul nu se poate incarca de pe discheta.

Cauza

Solutie

Discheta nu este incarcabila.

Tnlocuiti discheta cu una incarcabila.

TIncércarea de pe discheta a fost dezactivata in programul
Computer Setup.

1.  Executati programul Computer Setup si activati
incarcarea de pe discheta in Storage > Storage
Options (Stocare-Ordine incarcare).

2. Executati programul Computer Setup si activati
incarcarea dischetei in Storage > Storage Options >
Removable Media Boot (Stocare-Optiuni stocare-
Incércare de pe suporturi amovibile).

NOTA: Ambii pasi trebuie sa fie utilizati cand functia
Removable Media Boot (Incércare de pe suporturi amovibile)
din Computer Setup ignora comanda activata Boot Order
(Ordine incarcare).

Modul server de retea este activat in programul Computer
Setup.

Executati programul Computer Setup si dezacrtivati Network
Server Mode (Mod server de retea) in Security > Password
Options (Securitate-Optiuni parola).

Incércarea de pe suporturi amovibile a fost dezactivats in
programul Computer Setup.

Executati programul Computer Setup si activati incarcarea de
pe suporturi amovibile in Storage > Storage Options >
Removable Media Boot (Stocare-Optiuni stocare-Incarcare
de pe suporturi amovibile).
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Rezolvarea problemelor legate de unitatea de disc

Tabelul 2-4 Rezolvarea problemelor legate de unitatea de disc

A survenit o eroare la unitatea de disc.

Cauza

Solutie

Unitatea de disc are sectoare deteriorate sau s-a defectat.

1. In Microsoft Windows XP, faceti clic cu butonul din
dreapta al mouse—ului pe Start, faceti clic pe Explore
(Explorare) si selectati o unitate. Selectati File (Figier) >
Properties (Proprietati) > Tools (Instrumente). Sub
Error—checking (Verificare eroare), faceti clic pe Check
Now (Verificare acum).

Tn Microsoft Windows Vista, faceti clic cu butonul din
dreapta al mouse—ului pe Start, faceti clic pe Explore
(Explorare) si faceti clic cu butonul din dreapta al mouse—
ului pe o unitate. Selectati Properties (Proprietati), apoi
selectati fila Tools (Instrumente). Sub Error—checking
(Verificare eroare) faceti clic pe Check Now (Verificare
acum).

2. Utilizati un utilitar pentru a localiza si bloca uzarea
sectoarelor deteriorate. Dacéa este necesar, reformatati
unitatea de disc.

Problema la tranzactia pe disc.

Cauza

Solutie

Fie structura directoarelor este necorespunzatoare, fie exista
o problema cu un fisier.

n Microsoft Windows XP, faceti clic cu butonul din dreapta al
mouse—ului pe Start, faceti clic pe Explore (Explorare) si
selectati o unitate. Selectati File (Fisier) > Properties
(Proprietati) > Tools (Instrumente). Sub Error—checking
(Verificare eroare), faceti clic pe Check Now (Verificare
acum).

Tn Microsoft Windows Vista, faceti clic cu butonul din dreapta
al mouse—ului pe Start, faceti clic pe Explore (Explorare) si
faceti clic cu butonul din dreapta al mouse—ului pe o unitate.
Selectati Properties (Proprietati), apoi selectati fila Tools
(Instrumente). Sub Error—checking (Verificare eroare) faceti
clic pe Check Now (Verificare acum).

Unitatea nu a fost gasita (identificata).

Cauza

Solutie

Cablul este slabit.

Verificati conexiunile cablului.

Sistemul nu a recunoscut automat un dispozitiv nou instalat.

Consultati instructiunile de reconfigurare din sectiunea
Rezolvarea problemelor de instalare a hardware-lui,

la pagina 34. Daca sistemul nu recunoaste inca noul
dispozitiv, examinati daca dispozitivul este listat in cadrul
programului Computer Setup. Daca este listat, cauza
probabila este o problema de driver. Daca nu este listat, cauza
probabila este o problema de hardware.

Daca acesta este o unitate nou instalata, executati utilitarul
Computer Setup si incercati sa adaugati o intarziere pentru
testele POST sub Advanced > Power-On (Avansat-Pornire).

Dispozitivul este atagat la un port SATA care a fost ascuns in
Computer Setup.

Executati utilitarul Computer Setup si asigurati-va ca Device
Available (Dispozitiv disponibil) este selectat pentru portul
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Tabelul 2-4 Rezolvarea problemelor legate de unitatea de disc (Continuare)

Unitatea nu a fost gasita (identificata).

Cauza

Solutie

SATA al dispozitivului din Security (Securitate) > Device
Security (Securitate dispozitiv).

Unitatea raspunde lent imediat dupa conectare.

Executati programul Computer Setup si mariti intarzierea
pentru testele POST in Advanced > Power-On Options
(Avansat-Optiuni de pornire).

Mesaj care indica disc non-sistem/lipsa NTLDR.

Cauza

Solutie

Sistemul incearca sa porneasca de pe o discheta care nu este
incarcabila.

Scoateti discheta din unitatea de discheta.

Sistemul incearca sa porneasca de pe unitatea de disc dar
este posibil ca aceasta sa fi fost deteriorata.

1. Introduceti o dischet& incéarcabila in unitatea de discheta
si porniti din nou computerul.

2. \Verificati formatul unitétii de disc utilizand fdisk: In cazul
formatarii NTFS, utilizati un alt cititor pentru a evalua
unitatea. In cazul formatarii FAT32, unitatea de disc nu
poate fi accesata.

Lipsesc figiere de sistem sau nu sunt corect instalate.

1. Introduceti o discheta incarcabila in unitatea de discheta
si porniti din nou computerul.

2. Verificati formatul unitatii de disc utilizand Fdisk: Tn cazul
formatarii NFTFS, utilizati un alt cititor pentru a evalua
unitatea. In cazul formatarii FAT32, unitatea de disc nu
poate fi accesata.

3. Instalati fisiere de sistem pentru sistemul de operare
corespunzator.

Incarcarea de pe unitatea de disc a fost dezactivata in
programul Computer Setup.

Executati utilitarul Computer Setup si activati intrarea unitatii
de disc in lista Storage > Boot Order (Stocare-Ordine
incarcare).

Unitatea de disc pentru incarcare nu este atasata prima intr-o
configuratie cu mai multe unitati de disc.

Dacé se incearca incarcarea de pe o unitate de disc, asigurati-
va ca ea este atasata la conectorul cu eticheta P60 SATAO de
pe placa sistemului.

Controlerul unitatii de disc pentru incarcare nu este listat primul
in ordinea de incarcare.

Executati utilitarul Computer Setup si selectati Storage > Boot
Order (Stocare-Ordine incarcare) si asigurati-va ca imediat
sub intrarea Hard Drive (Unitate de disc) este listat controlerul
unitatii de disc pentru incarcare.

Computerul nu se incarca de pe unitatea de disc.

Cauza

Solutie

Dispozitivul este atasat la un port SATA care a fost ascuns in
Computer Setup.

Executati utilitarul Computer Setup si asigurati-va ca Device
Available (Dispozitiv disponibil) este selectat pentru portul
SATA al dispozitivului din Security (Securitate) > Device
Security (Securitate dispozitiv).

Ordinea de incarcare nu este corecta.

Executati utilitarul Computer Setup si schimbati secventa de
incarcare in Storage > Boot Order (Stocare-Ordine
incarcare).

»Tipul de emulare” al unitatii de disc este setat pe
+None” (Fara).

Executati utilitarul Computer Setup si schimbati ,Tipul de
emulare” pentru ,Unitate de disc” in detaliile dispozitivului sub
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Tabelul 2-4 Rezolvarea problemelor legate de unitatea de disc (Continuare)

Computerul nu se incarca de pe unitatea de disc.

Cauza

Solutie

Storage > Device Configuration (Stocare-Configuratie
dispozitiv).

Unitatea de disc este defecta.

Observati daca LED-ul de alimentare de pe panoul frontal
clipeste in culoare ROSIE si daca se aud semnale sonore.
Consultati Anexa A, Mesaje de eroare POST, |la pagina 51
pentru a determina cauzele posibile pentru clipirea in culoare
rosie si pentru codurile sonore.

Consultati Certificatul international de garantie limitata, pentru
termeni si conditii.

Computerul pare sa fie blocat.

Cauza

Solutie

Programul utilizat nu mai raspunde la comenzi.

Incercati procedura normala ,Shut Down” (Inchidere) din
Windows. In caz de nereusita, apasati butonul de alimentare
timp de patru sau mai multe secunde pentru a opri alimentarea.
Pentru a porni din nou computerul, apasati din nou pe butonul
de alimentare.

Unitatea de disc amovibil nu are alimentare de la carcasa unitatii de disc.

Cauza

Solutie

ncuietoarea de la carcasa nu este pe pozitia ,PORNIT”.

Introduceti cheia si rotiti incuietoarea cu 90 de grade n sens
orar. LED-ul verde din partea frontala a carcasei trebuie sa fie
aprins.

Cablul de alimentare de la sursa de alimentare a computerului
la rama carcasei nu este conectat corespunzator.

Verificati sursa de alimentare pentru a va asigura ca este
conectata corespunzator la partea din spate a ramei carcasei.

Unitatea de disc amovibil nu este recunoscuta de computer.

Cauza

Solutie

Suportul unitatii de disc amovibil nu este agezat complet in
rama carcasei sau unitatea de disc nu este asezata complet
n suport.

impinget,i suportul in rama carcasei astfel incat conectorul din
partea din spate a ramei sa fie bine pozitionat. Daca problema
nu se rezolva in acest fel, opriti computerul, scoateti suportul
si verificati pozitia corecta in suport a conectorului de la
unitatea de disc.

Carcasa unitatii de disc amovibil emite sunete scurte si LED-ul verde lumineaza intermitent.

Cauza

Solutie

A fost activata alarma pentru defectiune la ventilator, de la
carcasa unitatii de disc amovibil.

Opriti computerul si contactati HP pentru o carcasa de schimb.
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Rezolvarea problemelor legate de cititorul de cartele

Tabelul 2-5 Rezolvarea problemelor legate de cititorul de cartele

ROWW

Cartela nu functioneaza intr-o camera digitalad dupa formatarea ei in Microsoft Windows XP sau in Microsoft Windows

Vista.

Cauza

Solutie

Tn mod implicit, Windows XP si Windows Vista formateazi
cartelele cu capacitate mai mare decat 32 MO in format
FAT32. Majoritatea camerelor digitale utilizeaza formatul FAT
(FAT16 si FAT12) si nu pot sa functioneze cu o cartela de
format FAT32.

Fie formatati cartela in camera digitala, fie selectati sistemul
de figiere FAT pentru a formata cartela intr—un computer cu
Windows XP sau Windows Vista.

La incercarea de scriere pe cartela, a survenit o eroare de protectie la scriere sau de blocare.

Cauza

Solutie

Cartela este blocata. Blocarea cartelei este o caracteristica de
securitate care Impiedica scrierea pe si stergerea de pe o
cartela SD/Memory Stick/PRO.

Daca se utilizeaza o cartela SD, verificati daca péarghia de
blocare situata in partea dreapta a cartelei SD nu este in
pozitie blocata. Daca se utilizeaza o cartela Memory Stick/
PRO, verificati daca parghia de blocare situata in partea de jos
a cartelei Memory Stick/PRO nu este in pozitie blocata.

Nu se poate scrie pe cartela.

Cauza

Solutie

Cartela este o cartela ROM (read-only memory — memorie
numai pentru citire).

Verificati documentatia producatorului livratd impreuna cu
cartela pentru a vedea daca pentru aceasta exista posibilitatea
de scriere. Consultati sectiunea anterioara pentru o lista de
cartele compatibile.

Imposibil de accesat datele de pe cartela dupa introducerea acesteia intr-un slot.

Cauza

Solutie

Cartela nu este introdusa corect, nu este introdusa in slotul
corect sau nu este acceptata.

Verificati modul corect de introducere a cartelei, si anume
contactul aurit sa fie pe partea corespunzatoare. LED-ul verde
se aprinde daca modul de introducere este corect.

Nu se cunoaste modul corect de evacuare a unei cartele.

Cauza

Solutie

Pentru evacuarea in siguranta a cartelei se utilizeaza software-
ul computerului.

Deschideti My Computer (Computerul meu) in Windows XP
sau Computer in Windows Vista, faceti clic cu butonul din
dreapta al mouse—ului pe pictograma unitatii corespunzatoare
si selectati Eject (Evacuare). Apoi, evacuati cartela din slot.

NOTA: Nu evacuati niciodata cartela atunci cand LED-ul
verde clipeste

Rezolvarea problemelor legate de cititorul de cartele
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Tabelul 2-5 Rezolvarea problemelor legate de cititorul de cartele (Continuare)

Dupa instalarea cititorului de cartele si incarcarea in Windows, cititorul si cartelele introduse nu sunt recunoscute de

computer.

Cauza Solutie

Sistemul de operare necesita timp pentru a recunoaste Asteptati cateva secunde pentru ca sistemul de operare sa
dispozitivul atunci cand cititorul a fost instalat recent in poata recunoaste cititorul si porturile disponibile, ulterior fiind
computer si PC-ul este pornit pentru prima data. capabil sa recunoasca orice suport introdus in cititor.

Dupa introducerea unei cartele in cititor, computerul incearca sa incarce sistemul de pe cartela.

Cauza Solutie

Cartela introdusa are posibilitati de incarcare a sistemului. Daca nu doriti incarcarea sistemului de pe cartela, evacuati
cartela in timpul Tncarcarii sau nu selectati optiunea de
incarcare de pe cartela introdusa n timpul procesului de
incarcare.
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Rezolvarea problemelor legate de afisaj

Daca intdmpinati probleme legate de afigsaj, consultati documentatia livrata impreuna cu monitorul si
examinati cauzele si solutiile uzuale listate Tn tabelul urmator.

Tabelul 2-6 Rezolvarea problemelor legate de afigaj

Ecran gol (fara semnal video).

Cauza

Solutie

Monitorul nu este pornit, iar indicatorul luminos al monitorului
nu este aprins.

Porniti monitorul si verificati daca indicatorul luminos al
monitorului este aprins.

Monitor defect.

Tncercati un alt monitor.

Conexiunile cablurilor nu sunt corecte.

Verificati conexiunea prin cablu de la monitor la computer si
cea pana la priza electrica.

Este posibil sa aveti instalat un program utilitar pentru golirea
ecranului sau sa fie activate caracteristicile de economisire a
energiei.

Apasati orice tasta sau faceti clic cu mouse-ul si, daca este
stabilitd, introduceti parola.

Memoria ROM a sistemului este corupta; sistemul este in
modul de recuperare de urgenta a blocului de incarcare
(indicat prin opt semnale sonore).

Actualizati din nou memoria ROM a sistemului cu cea mai
recenta imagine BIOS. Pentru mai multe informatii, consultati
sectiunea ,Boot Block Emergency Recovery Mode” (Modul de
recuperare de urgenta a blocului de incarcare) din Desktop
Management Guide (Ghid de gestionare a computerului).

Utilizati un monitor cu sincronizare fix&, iar acesta nu se va
sincroniza la rezolutia selectata.

Verificati daca monitorul accepta aceeasi rata de scanare
orizontala ca si rezolutia selectata.

Computerul este in modul oprire temporara.

Apasati butonul de alimentare pentru a iesi din modul oprire
temporara.

ATENTIE: Cand incercati s& iesiti din modul oprire
temporara, nu tineti apasat butonul de alimentare mai mult de
patru secunde. In caz contrar, computerul se va opri si orice
date care nu au fost salvate se vor pierde.

Cablul monitorului nu este conectat in conectorul corect.

Daca sistemul computerului are atat un conector pentru placa
grafica integrata cat si un conector pentru placa grafica
suplimentara, conectati cablul monitorului in conectorul pentru
placa grafica, din partea din spate a computerului.

Setarile din computer aferente monitorului nu sunt compatibile
cu monitorul.

1. Tn panoul de control din Windows XP, faceti dublu clic pe
pictograma Display (Afisare) si selectati fila Settings
(Setari).

n panoul de control din Windows Vista, la Appearance
and Personalization (Aspect si personalizare), selectati
Adjust screen resolution (Ajustare rezolutie ecran).

Utilizati reglajul glisant pentru a reseta rezolutia.

Imposibil de activat placa grafica integrata dupa instalarea

unei placi grafice PCI Express.

Cauza

Solutie

La sistemele cu placa grafica integrata Intel, nu se poate activa
placa grafica integrata dupa ce s-a instalat o placa PCI
Express x16.

Placa grafica integrata se poate activa in programul Computer
Setup daca este instalata o placa grafica PCl sau PCI| Express
x1, dar nu poate fi activata daca exista o placa grafica in slotul
placii PCI Express x16.
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Tabelul 2-6 Rezolvarea problemelor legate de afigaj (Continuare)

Ecranul este gol si LED-ul de alimentare clipeste de cinci ori in culoare rosie, o data pe secunda, dupa care urmeaza
o pauza de doua secunde si computerul emite de cinci ori un semnal sonor. (Semnalele sonore se opresc dupa a
cincea repetare, dar LED-urile continua sa clipeasca.)

Cauza Solutie

Eroare inaintea memoriei video. 1. Repozitionati modulele DIMM. Porniti sistemul.

2. Pentru a identifica modulul defect, inlocuiti pe rand
modulele DIMM.

3. Inlocuiti memoria de la alti furnizori cu memorie de la HP.

4. Inlocuiti placa de sistem.

Ecranul este gol si LED-ul de alimentare clipeste de sase ori in culoare rosie, o data pe secunda, dupa care urmeaza
o pauza de doua secunde si computerul emite de sase ori un semnal sonor. (Semnalele sonore se opresc dupa a
cincea repetare, dar LED-urile continua sa clipeasca.)

Cauza Solutie

Eroare nainte de placa grafica video. Pentru sistemele cu o placa grafica:
1. Repozitionati placa grafica. Porniti sistemul.
2. Inlocuiti placa grafic.
3. Inlocuiti placa de sistem.

Pentru sistemele cu placa grafica integrata, inlocuiti placa de
sistem.

Ecranul este gol si LED-ul de alimentare clipeste de sapte ori in culoare rosie, o data pe secunda, dupa care urmeaza
o pauza de doua secunde si se emite de sapte ori un semnal sonor. (Semnalele sonore se opresc dupa a cincea
repetare, dar LED-urile continua sa clipeasca.)

Cauza Solutie

Defectiune la placa de sistem (memoria ROM a detectat o Tnlocuiti placa de sistem.
defectiune Tnainte de placa video).

Monitorul nu functioneaza corect atunci cand este utilizat cu caracteristicile de economisire a energiei.

Cauza Solutie

Se utilizeaza un monitor pentru care nu sunt prevazute Dezactivati caracteristica de economisire a energiei aferenta
posibilitati de economisire a energiei dar avand caracteristicile monitorului.
de economisire a energiei activate.

Caractere intunecate.

Cauza Solutie

Controalele pentru luminozitate si contrast nu sunt setate Ajustati controalele pentru luminozitate si contrast ale

corect. monitorului.

Cablurile nu sunt conectate corect. Verificati modul ferm de conectare la placa grafica si la monitor

pentru cablul aferent graficii.
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Tabelul 2-6 Rezolvarea problemelor legate de afisaj (Continuare)

Imagine neclara sau imposibil de setat rezolutia solicitata.

Cauza

Solutie

Daca s-a facut upgrade la controlerul grafic, este posibil sa nu
se poata incarca driverele corecte corespunzatoare graficii.

Instalati driverele video incluse Tn pachetul de upgrade.

Monitorul nu este capabil sa afigseze rezolutia solicitata.

Schimbati rezolutia solicitata.

Placa grafica este deteriorata.

Tnlocuiti placa grafica.

Imaginea are intreruperi, ruleaza, este instabila sau clipeste.

Cauza

Solutie

Conexiunile monitorului sunt imperfecte sau monitorul nu este
reglat corect.

1. Verificati modul ferm de conectare a cablul monitorului la

computer.

Tntr-un sistem cu doud monitoare sau daca un alt monitor
este In imediata apropiere, verificati daca monitoarele nu
interfereaza reciproc prin camp electromagnetic,
pozitionandu-le separat.

3. Este posibil ca lampi fluorescente sau ventilatoare sa fie
prea aproape de monitor.

Monitorul trebuie demagnetizat.

Demagnetizati monitorul. Pentru instructiuni, consultati
documentatia livrata impreuna cu monitorul.

Imaginea nu este centrata.

Cauza

Solutie

Este posibil ca pozitia sa necesite ajustari.

Apasati butonul Menu (Meniu) de la monitor pentru a accesa
meniul OSD. Selectati ImageControl/Horizontal Position
(Control imagine/Pozitie orizontald) sau Vertical Position
(Pozitie verticald) pentru a ajusta pozitia orizontala sau
verticala a imaginii.

Pe ecran se afigseaza ,,No Connection, Check Signal Cable”

(Lipsa conexiune, verificati cablul de semnal).

Cauza

Solutie

Cablul video al monitorului este deconectat.

Conectati cablul video intre monitor si computer.

ATENTIE: Asigurati-va ca alimentarea computerului este
oprita pe timpul conectarii cablului video.

Pe ecran se afigseaza ,,Out of Range” (in afara domeniului).

Cauza

Solutie

Rezolutia video si frecventa de reimprospatare sunt setate la
un nivel mai ridicat decat cel permis de monitor.

Reporniti computerul si introduceti Safe Mode (Mod protejat).
Modificati setarile in setari acceptate, apoi reporniti computerul
pentru ca noile setari sa aiba efect.
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Tabelul 2-6 Rezolvarea problemelor legate de afigaj (Continuare)

La alimentarea unui monitor CRT se aud zgomote din interior, caracteristice vibratiilor sau tubului electronic.

Cauza Solutie

A fost activata bobina de demagnetizare a monitorului. Nu exista. Este normal ca bobina de demagnetizare sa fie
activata cand se alimenteaza monitorul.

Din interiorul unui monitor CRT se aud pochnituri.

Cauza Solutie

Releele electronice au fost activate in interiorul monitorului. Nu exista. Este normal pentru anumite monitoare sa produca
zgomote de pocnituri la pornire si oprire, la intrarea si iesirea
din modul de oprire temporara, precum si la schimbarea
rezolutiilor.

Din interiorul unui monitor cu ecran plat se aud bazaituri excesive.

Cauza Solutie

Setarile pentru luminozitate si/sau contrast sunt realizate laun Reduceti nivelul la setarile pentru luminozitate si/sau contrast.
nivel prea ridicat.

Focalizare neclara; efecte de trenaj, de dublare sau de umbra; linii de defilare pe orizontala; bare verticale estompate;
sau imposibil de centrat imaginea pe ecran (monitoarele cu ecran plat utilizeaza numai conexiune de intrare VGA de

tip analog).

Cauza Solutie

Circuitele interne de conversie digitalda pentru monitorul cu 1. Tn meniul de afisare de pe ecranul monitorului, selectati
ecran plat nu pot sa interpreteze corect sincronizarea la iesire optiunea aferenta monitorului de reglare automata.

pentru placa grafica.
2. Sincronizati manual functiile de afigare pe ecran Clock si
Clock Phase. Pentru a descarca un pachet SoftPaq care
sa va asiste la sincronizare, accesati site-ul Web urmator,
selectati monitorul corespunzator si descarcati fie
SP32347, fie SP32202: http://www.hp.com/support

Placa grafica nu este pozitionata corect sau este defecta. 1. Repozitionati placa grafica.

2. Inlocuiti placa grafica.

Anumite simboluri particulare nu apar in mod corect.

Cauza Solutie

Fontul pe care il utilizati nu accepta tipul respectiv de simbol.  Utilizati Character Map pentru a localiza si a selecta simbolul
corespunzator. Faceti clic pe Start > All Programs >
Accessories > System Tools > Character Map (Start-Toate
programele-Accesorii-Instrumente de sistem-Harta
caractere). Aveti posibilitatea sa copiati simbolul din Character
Map intr-un document.
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Rezolvarea problemelor audio

Tn cazul in care computerul are caracteristici audio si intdmpinati probleme legate de sunet, examinati

ROWW

cauzele si solutiile uzuale listate in tabelul urmator.

Tabelul 2-7 Rezolvarea problemelor audio

Sunetul este intrerupt la intrare si iesire.

Cauza

Solutie

Resursele aferente procesorului sunt utilizate la alte aplicatii
deschise.

Tnchideti toate aplicatiile deschise care implica intens
procesorul.

Timp de intarziere pentru sunetul direct, specific pentru multe
aplicatii media player.

Numai in Windows XP:

1. Din Control Panel (Panou de control), selectati Sounds
and Audio Devices (Dispozitive sonore si audio).

2. Infila Audio, selectati un dispozitiv din lista Sound
Playback (Redare sunet).

3. Faceticlic pe butonul Advanced (Avansat) si selectati fila
Performance (Performante).

4. Setati cursorul Hardware acceleration (Acceleratie
hardware) pe None (Fara) si cursorul Sample rate
conversion quality (Calitate conversie rata de
esantionare) pe Good (Bun) si testati din nou semnalul
audio.

5.  Setati cursorul Hardware acceleration (Acceleratie
hardware) pe Full (Integral) si cursorul Sample rate
conversion quality (Calitate conversie rata de
esantionare pe Best (Cel mai bun) si testati din nou
semnalul audio.

Lipsa sunet la iesirea difuzorului sau castilor.

Cauza

Solutie

Controlul de volum aferent software—ului este dezactivat sau
setat pe volum anulat.

Faceti dublu clic pe pictograma Speaker (Difuzor) de pe bara
de activitati, apoi asigurati-va ca Mute (Dezactivare sunet) nu
este selectat si utilizati cursorul de volum pentru a ajusta
volumul.

Audio este ascuns in programul Computer Setup.

Activati audio in programul Computer Setup: Security >
Device Security > Audio (Securitate - Securitate dispozitiv —
Audio).

Difuzoarele externe nu sunt pornite.

Porniti difuzoarele externe.

E posibil ca dispozitivul audio sa fie conectat la o mufa
necorespunzatoare.

Verificati daca dispozitivul este conectat la mufa
corespunzatoare a computerului. Difuzoarele trebuie
conectate la mufa pentru iesire linie din spatele computerului,
iar castile la mufa pentru casti din partea frontala a
computerului.

Difuzoarele externe nu sunt conectate in mufa audio corecta
de pe placa de sunet recent instalata.

Pentru conectarea corecta a difuzoarelor, consultati
documentatia placii de sunet.

CD-ul audio digital nu este activat.

Activati CD-ul audio digital. In Device Manager (Manager
dispozitive), faceti clic cu butonul din dreapta al mouse-ului pe
dispozitivul CD/DVD si selectati Properties (Proprietati).
Asigurati-va ca optiunea Enable digital CD audio for this
CD-ROM device (Activare CD audio digital pentru acest
dispozitiv CD—ROM) este bifata.
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Tabelul 2-7 Rezolvarea problemelor audio (Continuare)

Lipsa sunet la iegirea difuzorului sau castilor.

Cauza

Solutie

Castile sau dispozitivele conectate la conectorul de iesire linie
dezactiveaza sunetul la difuzorul intern.

Porniti sistemul si utilizati casti sau difuzoare externe, daca
sunt prevazute sau deconectati castile sau difuzoarele
externe.

Computerul este in modul oprire temporara.

Apasati butonul de alimentare pentru a iesi din modul oprire
temporara.

ATENTIE: Céand incercati sa iesiti din modul oprire
temporara, nu tineti apasat butonul de alimentare mai mult de
patru secunde. In caz contrar, computerul se va opri si orice
date care nu au fost salvate se vor pierde.

Difuzorul intern este dezactivat in programul Computer Setup.

Activati difuzorul intern in programul Computer Setup.
Selectati Advanced (Complex) > Device Options (Optiuni
dispozitiv) > Internal Speaker (Difuzor intern).

Sunetul din casti nu este clar sau este atenuat.

Cauza

Solutie

Castile sunt conectate la conectorul de iesire audio situat in
partea din spate. Conectorul de iesire audio din partea din
spate este prevazut pentru dispozitive audio alimentate si nu
este destinat utilizarii castilor.

Conectati castile in conectorul pentru casti prevazut in partea
frontala a computerului.

Computerul este aparent blocat in timpul inregistrarii audio.

Cauza

Solutie

Discul este complet incarcat.

Tnainte de inregistrare, verificati daca exista spatiu suficient pe
disc. Aveti posibilitatea sa inregistrati fisierul audio si intr-un
format comprimat.

Mufa pentru intrare linie nu functioneaza corespunzator.

Cauza

Solutie

Mufa a fost reconfigurata in driverul audio sau in software—ul
aplicatiei.

Tn driverul audio sau in software—ul aplicatiei, reconfigurati
mufa sau setati—o la valoarea implicita.
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Rezolvarea problemelor legate de imprimanta

Daca intdmpinati probleme legate de imprimanta, consultati documentatia livrata impreuna cu
imprimanta si examinati cauzele si solutiile uzuale listate in tabelul urmator.

ROWW

Tabelul 2-8 Rezolvarea problemelor legate de imprimanta

Imprimanta nu imprima.

Cauza

Solutie

Imprimanta nu este pornita si conectata.

Porniti imprimanta si verificati daca este conectata.

Driverele de imprimanta corespunzatoare pentru acest tip de
aplicatie nu sunt instalate.

1. Instalati driverul de imprimanta corespunzator aplicatiei.
2. Incercati s& imprimati utilizand comanda MS-DOS:
DIR C:\ > [printer port]

unde [printer port] este adresa imprimantei utilizate.
Daca imprimanta functioneaza, reincarcati driverul de
imprimanta.

Daca sunteti intr-o retea, nu este necesar sa conectati
imprimanta.

Realizati conexiunile corespunzatoare de retea pentru
imprimanta.

Imprimanta s-a defectat.

Executati testarea automata pentru imprimanta.

Imprimanta nu porneste.

Cauza

Solutie

Cablurile nu sunt conectate corect.

Reconectati toate cablurile si verificati cablul de alimentare si
priza electrica.

Imprimanta nu imprima cu exactitate informatia.

Cauza

Solutie

Driverul de imprimanta corespunzator pentru acest tip de
aplicatie nu este instalat.

Instalati driverul de imprimanta corespunzator aplicatiei.

Cablurile nu sunt conectate corect.

Reconectati toate cablurile.

Memoria imprimantei este supraincarcata.

Resetati imprimanta prin oprirea ei timp de un minut, apoi
reporniti.

Imprimanta nu este conectata.

Cauza

Solutie

Imprimanta nu mai are hartie.

Verificati tava pentru hartie si reincarcati-o daca este goala.
Selectati online.
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Rezolvarea problemelor legate de tastatura si mouse

Daca intdmpinati probleme legate de tastatura si mouse, consultati documentatia livrata impreuna cu
echipamentul si examinati cauzele si solutiile uzuale listate n tabelul urmator.

Tabelul 2-9 Rezolvarea problemelor legate de tastatura si mouse

Comenzile si tastarea prin intermediul tastaturii nu sunt recunoscute de computer.

Cauza

Solutie

Cablul tastaturii nu este conectat corect.

1. Pe desktopul Windows XP, faceti clic pe Start > Shut
Down (inchidere).

Pe desktopul Windows Vista, faceti clic pe Start, faceti
clic pe sageata din coltul din dreapta-jos al meniului Start,
apoi selectati Shut Down (Inchidere).

2. Dupa terminarea procedurii de inchidere, reconectati
tastatura in partea din spate a computerului si reporniti
computerul.

Programul utilizat nu mai raspunde la comenzi.

Tnchidet,i computerul utilizdnd mouse-ul, apoi reporniti
computerul.

Tastatura necesita reparatii.

Consultati Certificatul international de garantie limitata, pentru
termeni si conditii.

Eroare la dispozitivul fara fir.

1. Verificati software-ul, daca este disponibil, relativ la
starea dispozitivului.

2. Verificati/inlocuiti bateriile dispozitivului.

3. Resetati receptorul si tastatura.

Computerul este in modul oprire temporara.

Apasati butonul de alimentare pentru a iesi din modul oprire
temporara.

ATENTIE: Céand incercati sa iesiti din modul oprire
temporara, nu tineti apasat butonul de alimentare mai mult de
patru secunde. In caz contrar, computerul se va opri si orice
date care nu au fost salvate se vor pierde.

Cursorul nu se migca la utilizarea tastelor sageti de pe tastatura.

Cauza

Solutie

Este posibil ca tasta Num Lock sa fie apasata.

Apasati tasta Num Lock. Indicatorul luminos Num Lock nu
trebuie sé fie aprins cand utilizati tastele sageti. Tasta Num
Lock se poate dezactiva (sau activa) din programul Computer
Setup.
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Tabelul 2-10 Rezolvarea problemelor legate de mouse

Mouse-ul nu raspunde la migcare sau este prea lent.

Cauza

Solutie

Conectorul aferent mouse-ului nu este conectat corect in
partea din spate a computerului.

Tnchideti computerul utilizand tastatura.

1. Apasati simultan tastele Ctrl si Esc (sau apasati tasta
Windows logo) pentru a afisa meniul Start.

2.  Utilizati tastele sageti pentru a selecta Shut Down
(inchidere), apoi ap&sati tasta Enter.

3. Dupa terminarea procedurii de inchidere, conectati
conectorul aferent mouse-ului (sau tastaturii) in partea
din spate a computerului gi reporniti computerul.

Programul utilizat nu mai raspunde la comenzi.

Tnchidet,i computerul utilizdnd tastatura, apoi reporniti
computerul.

Mouse-ul necesita operatii de curatare.

Scoateti capacul de protectie pentru bila aferentd mouse-ului
si curatati componentele interne.

Mouse-ul necesité reparatii.

Consultati Certificatul international de garantie limitata, pentru
termeni si conditii.

Eroare la dispozitivul fara fir.

1. Verificati software-ul, daca este disponibil, relativ la
starea dispozitivului.

2. Verificati/inlocuiti bateriile dispozitivului.

3. Resetati receptorul si mouse-ul.

Computerul este in modul oprire temporara.

Apasati butonul de alimentare pentru a iesi din modul oprire
temporara.

ATENTIE: Cand incercati sé iesiti din modul oprire
temporara, nu tineti apasat butonul de alimentare mai mult de
patru secunde. In caz contrar, computerul se va opri si orice
date care nu au fost salvate se vor pierde.

Mouse-ul efectueaza miscari numai pe verticala si orizontala sau migcarea se realizeaza cu intreruperi.

Cauza

Solutie

Bila aferenta mouse-ului sau ansamblul traductor de axe de
rotatie care intra in contact cu bila sunt murdare.

Scoateti capacul de protectie al bilei de la partea de jos a
mouse-ului si curatati componentele interne cu un set de
curatare pentru mouse, disponibil in majoritatea magazinelor
pentru computere.
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Rezolvarea problemelor de instalare a hardware-lui

Cand adaugati sau eliminati hardware precum o unitate suplimentara sau o placa de extensie, este
posibil sa fie necesara reconfigurarea computerului. Cand instalati un dispozitiv plug—and—play,
Windows recunoaste dispozitivul si configureaza computerul in mod automat. Daca instalati un
dispozitiv care nu este plug—and—play, dupa finalizarea instalarii hardware—ului nou trebuie sa
reconfigurati computerul. Tn Windows, utilizati Add Hardware Wizard (Expert adaugare hardware) si

urmati instructiunile care apar pe ecran.

AVERTISMENT!

Cand computerul este conectat la o sursa de curent alternativ, la placa de sistem se

aplica intotdeauna o tensiune. Pentru a reduce riscul de ranire din cauza socurilor electrice si/sau a
suprafetelor fierbinti, decuplati cablul de alimentare de la priza si asteptati pana cand componentele
interne ale sistemului se racesc, inainte de a le atinge.

Tabelul 2-11 Rezolvarea problemelor de instalare a hardware-lui

Un dispozitiv nou nu este recunoscut ca parte a sistemului.

Cauza

Solutie

Dispozitivul nu este pozitionat sau conectat corect.

Verificati daca dispozitivul este conectat ferm si in pozitia
corecta si daca nici un pin al conectorului nu este indoit.

Cabilul (cablurile) noului dispozitiv extern sunt slabite sau
cablurile de alimentare nu sunt conectate.

Verificati daca toate cablurile sunt conectate ferm si in pozitia
corecta si daca nici un pin al cablului sau al conectorului nu
este indoit.

Comutatorul de alimentare al noului dispozitiv extern nu este
pornit.

Opriti computerul, porniti dispozitivul extern, apoi porniti
computerul pentru a integra dispozitivul in sistem.

Cand sistemul v-a recomandat modificari ale configuratiei, nu
le-ati acceptat.

Reporniti computerul si urmati instructiunile pentru a accepta
modificarile.

Daca configuratia implicita intra in conflict cu alte dispozitive,
este posibil ca o placa plug-and-play sa nu se configureze
automat cand este adaugata.

Utilizati Device Manager (Manager dispozitive) din Windows
pentru a deselecta setarile automate pentru placa si optati
pentru o configuratie de baza care nu provoaca un conflict intre
resurse. Pentru a rezolva conflictul dintre resurse, se poate
utiliza si programul Computer Setup pentru reconfigurarea sau
dezactivarea dispozitivelor.

Porturile USB sunt dezactivate in Computer Setup.

Introduceti Computer Setup (F10) si activati porturile USB.

Computerul nu porneste.

Cauza

Solutie

S-au utilizat module de memorie necorespunzatoare pentru
upgrade sau modulele de memorie au fost instalate intr-o
amplasare gresita.

1. Pentru a determina daca utilizati modulele de memorie
corespunzatoare si pentru a verifica daca sunt instalate
corect, consultati documentatia livrata impreuna cu
sistemul.

NOTA: DIMM 1 trebuie, de asemenea, s3 fie instalat.
2. Observati semnalele sonore si LED-urile de pe panoul
frontal al computerului. Semnalele sonore si LED-urile cu

lumina intermitenta sunt coduri pentru anumite probleme.

3. Daca problema nu se rezolva nici astfel, contactati
asistenta pentru clienti.
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Tabelul 2-11 Rezolvarea problemelor de instalare a hardware-lui (Continuare)

LED-ul de alimentare clipeste de cinci ori in culoare rosie, o data pe secunda, dupa care urmeaza o pauza de doua
secunde si se emite de cinci ori un semnal sonor. (Semnalele sonore se opresc dupa a cincea repetare, dar LED-urile

continua sa clipeasca.)

Cauza

Solutie

Memoria este instalata incorect sau este deteriorata.

ATENTIE: Pentru a evita deteriorarea modulelor DIMM sau
a placii de sistem, trebuie sa decuplati cablul de alimentare a
computerului, inainte de a incerca sa repozitionati, sa instalati
sau sa scoateti un modul DIMM.

1. Repozitionati modulele DIMM. Porniti sistemul.

2. Pentru a identifica modulul defect, inlocuiti pe rand
modulele DIMM.

NOTA: DIMM 1 trebuie, de asemenea, sa fie instalat.
3. Tnlocuiti memoria de la alti furnizori cu memorie de la HP.

4. Tnlocuiti placa de sistem.

LED-ul de alimentare clipeste de sase ori in culoare rosie, o data pe secunda, dupa care urmeaza o pauza de doua
secunde si se emite de sase ori un semnal sonor. (Semnalele sonore se opresc dupa a cincea repetare, dar LED-urile

continua sa clipeasca.)

Cauza

Solutie

Placa grafica nu este pozitionata corect sau este defecta sau
placa de sistem este defecta.

Pentru sistemele cu o placa grafica:

1. Repozitionati placa grafica. Porniti sistemul.
2. nlocuiti placa grafica.

3. Tnlocuiti placa de sistem.

Pentru sistemele cu placa grafica integrata, inlocuiti placa de
sistem.

LED-ul de alimentare clipeste de zece ori in culoare rosie, o data pe secunda, dupa care urmeaza o pauza de doua
secunde si se emite de zece ori un semnal sonor. (Semnalele sonore se opresc dupa a cincea repetare, dar LED-urile

continua sa clipeasca.)

Cauza

Solutie

Placa optionala defecta.

1. Verificati fiecare placa optionala scotand placile cate una
la un moment dat (daca sunt mai multe placi), apoi
alimentati sistemul pentru a constata daca defectiunea
dispare.

2. Din momentul identificarii placii defecte, scoateti si
nlocuiti placa de optiuni defecta.

3. Tnlocuiti placa de sistem.
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Rezolvarea problemelor legate de retea

Céateva din cauzele si solutiile uzuale pentru problemele legate de retea sunt listate in tabelul urmator.
Aceste indicatii nu fac referire la procesul de depanare pentru cablarea de retea.

Tabelul 2-12 Rezolvarea problemelor legate de retea

Caracteristica Wake-on-LAN nu functioneaza.

Cauza Solutie

Caracteristica Wake-on-LAN nu este activata. Pentru a activa Wake-on-LAN in Windows XP:

1. Selectati Start > Control Panel (Start — Panou de
control).

2. Faceti dublu clic pe Network Connections (Conexiuni
de retea).

3. Faceti dublu clic pe Local Area Connection (Conexiune
de retea locala).

4. Faceti clic pe Properties (Proprietati).

5. Faceti clic pe Configure (Configurare).

6. Faceti clic pe fila Power Management (Management
energetic), apoi selectati caseta Allow this device to
bring the computer out of standby (Se permite acestui
dispozitiv sa scoatd computerul din starea de asteptare).

Pentru a activa Wake-on-LAN in Windows Vista:

1. Selectati Start > Control Panel (Panou de control).

2. La Network and Internet (Retea si Internet), selectati
View network status and tasks (Vizualizare stare si

sarcini retea).

3. Inlista Tasks (Activitati), selectati Manage network
connections (Gestionare conexiuni retea).

4. Faceti dublu clic pe Local Area Connection (Conexiune
de retea locala).

5.  Faceti clic pe butonul Properties (Proprietati).

6. Faceti clic pe butonul Configure (Configurare).

7.  Faceti clic pe fila Power Management (Management
alimentare), apoi selectati caseta Allow this device to

wake the computer (Se permite acestui dispozitiv sa
destepte computerul).

Driverul de retea nu detecteaza controlerul de retea.

Cauza Solutie

Controlerul de retea este dezactivat. 1.  Executati programul Computer Setup si activati
controlerul de retea.

2. Activati controlerul de retea in sistemul de operare prin
Device Manager (Manager de dispozitive).

Driver de retea incorect. Verificati documentatia aferenta controlerului de retea pentru
a afla driverul corespunzator sau procurati-va cel mai recent
driver de pe site-ul Web al producatorului.
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Tabelul 2-12 Rezolvarea problemelor legate de retea (Continuare)

LED-ul de legatura pentru starea retelei nu clipeste.

NOTA: LED-ul de stare a retelei trebuie sa clipeasca atunci cand exista activitate in retea.

Cauza

Solutie

Nu s-a detectat nici o retea activa.

Verificati conectarea corespunzatoare pentru cablare si
echipamentul de retea.

Controlerul de retea nu este configurat corect.

Verificati starea dispozitivului in Windows, cum ar fi Device
Manager (Manager dispozitive) pentru incarcarea driverelor si
aplicatia Network Connections (Conexiuni de retea) din
Windows pentru starea legaturii.

Controlerul de retea este dezactivat.

1.  Executati programul Computer Setup si activati
controlerul de retea.

2. Activati controlerul de retea in sistemul de operare prin
Device Manager (Manager de dispozitive).

Driverul de retea nu este incarcat corect.

Reinstalati driverele de retea.

Sistemul nu poate detecta reteaua.

Dezactivati posibilitatile de auto—detectare si impuneti
sistemului modul de operare corect.

Procedura de diagnosticare indica o defectiune.

Cauza

Solutie

Cablul nu este conectat ferm.

Verificati modul ferm de fixare pentru cablu la conectorul de
retea, respectiv pentru celalalt capat al cablului la dispozitivul
corespunzator.

Cablul nu este fixat in conectorul corect.

Verificati legatura cablului in conectorul corect.

Exista o problema la cablu sau la dispozitivul de la celalalt
capat al cablului.

Verificati modul corect de utilizare a cablului sau a
dispozitivului de la celalalt capat al cablului.

Intreruperea controlerului de retea este partajata cu o placa de
extensie.

Sub meniul Advanced (Avansat) din Computer Setup,
modificati setarile pentru placa aferente resursei.

Controlerul de retea este defect.

Contactati un furnizor de servicii autorizat.

Procedura de diagnosticare a fost parcursa, dar computerul nu comunica cu reteaua.

Cauza

Solutie

Driverele de retea nu se incarca sau parametrii de driver nu
corespund configuratiei actuale.

Verificati daca driverele de retea se incarca si daca parametrii
de driver corespund configuratiei aferente controlerului de
retea.

Verificati daca protocolul, respectiv clientul de retea este
instalat in mod corespunzator.

Controlerul de retea nu este configurat pentru acest computer.

Selectati pictograma Network (Retea) in Control Panel
(Panou de control) si configurati controlerul de retea.

Controlerul de retea nu mai functioneaza atunci cand o placa de extensie este adaugata la computer.

Cauza

Solutie

Intreruperea controlerului de retea este partajata cu o placa de
extensie.

Sub meniul Advanced (Avansat) din Computer Setup,
modificati setérile pentru placa aferenta resursei.
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Tabelul 2-12 Rezolvarea problemelor legate de retea (Continuare)

Controlerul de retea nu mai functioneaza atunci cand o placa de extensie este adaugata la computer.

Cauza

Solutie

Controlerul de retea necesita drivere.

Verificati daca driverele nu au fost eliminate in mod accidental
atunci cand au fost instalate drivere pentru o noua placa de
extensie.

Placa de extensie instalata este o placa de retea (NIC) si intra
n conflict cu placa incorporata NIC.

Sub meniul Advanced (Avansat) din Computer Setup,
modificati setarile pentru placa aferenta resursei.

Controlerul de retea nu mai functioneaza, aparent fara nici un motiv.

Cauza

Solutie

Figierele care contin driverele de retea sunt corupte.

Reinstalati driverele de retea, utilizdnd CD-ul Restore Plus!.

Cablul nu este conectat ferm.

Verificati modul ferm de fixare pentru cablu la conectorul de
retea, respectiv pentru celalalt capat al cablului la dispozitivul
corespunzator.

Controlerul de retea este defect.

Contactati un furnizor de servicii autorizat.

Noua placa de retea nu incarca sistemul.

Cauza

Solutie

Este posibil ca noua placa de retea sa fie defecta sau sa nu
corespunda specificatiilor de standard industrial.

Instalati o placa NIC de standard industrial sau modificati
secventa de incarcare pentru a incarca din alta sursa.

Nu se realizeaza conectarea la serverul de retea cand se incearca instalarea de la distanta a sistemului.

Cauza

Solutie

Controlerul de retea nu este configurat corect.

Verificati conectivitatea de retea, existenta unui server DHCP
si faptul ca serverul pentru instalarea de la distanta a
sistemului contine driverele NIC pentru placa NIC aferenta
sistemului dvs.

Utilitarul de setare a sistemului raporteaza ca EEPROM nu este programat.

Cauza

Solutie

EEPROM neprogramat.

Contactati un furnizor de servicii autorizat.
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Rezolvarea problemelor legate de memorie

ROWW

Daca intdmpinati probleme legate de memorie, examinati cauzele si solutiile uzuale prezentate partial
in tabelul urmator.

ATENTIE: Este posibil ca modulele DIMM sa raméana alimentate in continuare cand computerul este
oprit (in functie de setarile Management Engine (Motor de gestionare) (ME)). Pentru a evita deteriorarea
modulelor DIMM sau a placii de sistem, trebuie sa decuplati cablul de alimentare a computerului, Thainte
de a incerca sa repozitionati, sa instalati sau sa scoateti un modul DIMM.

Pentru sistemele care accepta memorie ECC, HP nu accepta existenta simultana a memoriei ECC si
a memoriei non-ECC. In caz contrar, computerul nu va incarca sistemul de operare.

NOTA: Contorul de memorie va fi afectat de configuratiile cu care a fost activat Management Engine
(Motor de gestionare) (ME). ME utilizeazd 8MO ai memoriei de sistem Th modul cu un singur canal sau
16 MO ai memoriei Tn modul cu doua canale, pentru a descarca, a decomprima si a executa firmware-
ul ME pentru Out-of-Band (OOB), stocarea de date externe si alte functii de gestionare.

Tabelul 2-13 Rezolvarea problemelor legate de memorie

Sistemul nu se incarca sau nu functioneaza corect dupa instalarea modulelor de memorie suplimentare.

Cauza Solutie

Tn soclul XMM1 nu este instalat un modul de memorie. Asigurati-va ca un modul de memorie este instalat in slotul
XMM1 de pe placa de sistem. Acest soclu trebuie sa fie
fncarcat cu un modul de memorie.

Tipul modulului de memorie nu este corect sau gradul de viteza Tnlocuit,i modulul cu un dispozitiv care se incadreaza intr-un
pentru sistem sau pentru noul modul de memorie nu este setat standard industrial corect pentru computer. Pe unele modele,
corespunzator. modulele de memorie ECC si non-ECC nu se pot combina.

Eroare datorata lipsei de memorie.

Cauza Solutie

Este posibil sa nu fie setata corect configuratia memoriei. Utilizati Device Manager (Manager dispozitive) pentru a
verifica modul de configurare a memoriei.

Nu aveti memorie suficienta pentru a executa aplicatia. Examinati documentatia aplicatiei, pentru a determina
cerintele de memorie.

Contorul de memorie nu functioneaza corect in timpul testelor POST.

Cauza Solutie

Este posibil ca modulele de memorie sa nu fie instalate corect.  Verificati daca modulele de memorie au fost instalate corect si
daca sunt utilizate modulele corespunzatoare.

Este posibil ca placa grafica integrata sa utilizeze memoria de Nu este necesara nici o actiune.
sistem.

Eroare datorata memoriei insuficiente in timpul operarii.

Cauza Solutie

Sunt instalate prea multe programe Terminate and Stay Stergeti programele TSR de care nu aveti nevoie.
Resident (TSR).

Nu aveti memorie suficienta pentru aplicatie. Verificati cerintele de memorie pentru aplicatie sau adaugati
mai multd memorie in computer.
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Tabelul 2-13 Rezolvarea problemelor legate de memorie (Continuare)

LED-ul de alimentare clipeste de cinci ori in culoare rosie, o data pe secunda, dupa care urmeaza o pauza de doua
secunde si se emite de cinci ori un semnal sonor. (Semnalele sonore se opresc dupa a cincea repetare, dar LED-urile
continua sa clipeasca.)

Cauza Solutie

Memoria este instalata incorect sau este deteriorata. 1. Repozitionati modulele DIMM. Porniti sistemul.

2. Pentru a identifica modulul defect, inlocuiti pe rand
modulele DIMM.

3. Inlocuiti memoria de la alti furnizori cu memorie de la HP.

4. Inlocuiti placa de sistem.
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Rezolvarea problemelor legate de procesor

ROWW

Daca intdmpinati probleme legate de procesor, cauzele si solutiile uzuale sunt prezentate in tabelul
urmator.

Tabelul 2-14 Rezolvarea problemelor legate de procesor

Sistemul functioneaza cu performante reduse.

Cauza Solutie
Procesorul este incins. 1. Asigurati-va ca fluxul de aer spre computer nu este
blocat.

2. Verificati daca ventilatoarele sunt conectate si
functioneaza corect (unele ventilatoare functioneaza
numai cand este necesar).

3. Verificati daca radiatorul procesorului este instalat corect.

LED-ul de alimentare clipeste rosu de trei ori, o data pe secunda, dupa care urmeaza o pauza de doua secunde.

Cauza Solutie

Procesorul nu este pozitionat corect sau nu este instalat. 1. Verificati daca este prezent procesorul.

2. Repozitionati procesorul.

LED-ul rosu de alimentare clipeste de unsprezece ori, o data pe secunda, dupa care urmeaza o pauza de doua secunde.

Cauza Solutie

Procesorul curent nu accepta o caracteristica activata in 1. Instalati un procesor de fisiere de tip TXT.
prealabil in sistem.
2. Dezactivati caracteristica TXT din programul utilitar
Computer Setup (F10).

3. Reinstalati procesorul original.
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Rezolvarea problemelor legate de CD-ROM si DVD

Daca intdmpinati probleme legate de CD-ROM sau DVD, consultati cauzele si solutiile uzuale listate Tn
tabelul urmator sau in documentatia livrata Tmpreuna cu unitatea optica.

Tabelul 2-15 Rezolvarea problemelor legate de CD-ROM si DVD

Sistemul nu se incarca din unitatea CD-ROM sau DVD.

Cauza Solutie

Dispozitivul este atagat la un port SATA care a fost ascuns in  Executati utilitarul Computer Setup si asigurati-va ca Device

programul utilitar Computer Setup. Available (Dispozitiv disponibil) este selectat pentru portul
SATA al dispozitivului din Security (Securitate) > Device
Security (Securitate dispozitiv).

Functia Removable Media Boot (Incrcare de pe suporturi Executati programul utilitar Computer Setup si activati

amovibile) este dezactivata in utilitarul Computer Setup. incarcarea pe suporturi amovibile in Storage > Storage
Options (Stocare-Optiuni stocare). Asigurati-va ca CD-ROM-
ul este activat in Storage > Boot Order (Stocare — Ordine

incarcare).
Modul server de retea este activat in programul Computer Executati programul utilitar Computer Setup si dezactivati
Setup. Network Server Mode (Mod server de retea) in Security >

Password Options (Securitate-Optiuni parola).

CD-ul din unitate nu se poate incarca. incercat,i n unitate un CD care se poate incarca.

Ordinea de incarcare nu este corecta. Executati utilitarul Computer Setup si schimbati secventa de
incarcare in Storage > Boot Order (Stocare-Ordine
incarcare).

Unitatea nu a fost gasita (identificata).

Cauza Solutie

Cablul este slabit. Verificati conexiunile cablului.

Sistemul nu a recunoscut automat un dispozitiv nou instalat. ~ Consultati instructiunile de reconfigurare din sectiunea
Rezolvarea problemelor de instalare a hardware-lui,
la pagina 34. Daca sistemul nu recunoaste inca noul dispozitiv,
examinati daca dispozitivul este listat in cadrul programului
Computer Setup. Daca este listat, cauza probabila este o
problema de driver. Daca nu este listat, cauza probabila este
o problema de hardware.

Daca acesta este o unitate instalata mai recent, executati
utilitarul Computer Setup si incercati sa adaugati o intarziere
pentru testele POST sub Advanced > Power-On (Avansat-
Pornire).

Dispozitivul este atasat la un port SATA care a fost ascuns in  Executati utilitarul Computer Setup si asigurati-va ca Device

Computer Setup. Available (Dispozitiv disponibil) este selectat pentru portul
SATA al dispozitivului din Security (Securitate) > Device
Security (Securitate dispozitiv).

Unitatea raspunde cu intarziere imediat dupa conectare. Executati programul Computer Setup si mariti intarzierea
pentru testele POST in Advanced > Power-On Options
(Avansat-Optiuni de pornire).

Dispozitivele CD-ROM sau DVD nu sunt detectate sau driverul nu este incarcat.

Cauza Solutie
Unitatea nu este conectata corespunzator sau nu este Consultati documentatia livrata impreuna cu dispozitivul
configurata corespunzator. optional.

42 Capitolul 2 Depanare fara diagnosticare ROWW



ROWW

Tabelul 2-15 Rezolvarea problemelor legate de CD-ROM si DVD (Continuare)

Nu se redau filme din unitatea DVD.

Cauza

Solutie

Este posibil ca filmul sa aiba setari regionale pentru alta tara.

Consultati documentatia livrata impreuna cu unitatea DVD.

Nu este instalat software de decodare.

Instalati software de decodare.

Suport defect.

Tnlocuiti suportul.

Evaluarea filmului a fost blocata de blocarea originala.

Utilizati software-ul de DVD pentru a elimina blocarea
originala.

Suportul a fost instalat invers.

Reinstalati suportul.

Nu se evacueaza CD-ul (unitate incarcare tava).

Cauza

Solutie

Discul nu este asezat corect in unitate.

Tnchidet_i computerul, apoi introduceti o mica tija metalica in
orificiul pentru evacuare de urgentéa si apasati cu fermitate.
Trageti cu grija in afara tava din unitate, pana cand tava este
extinsa complet, apoi scoateti discul.

Unitatea CD-ROM, CD-RW, DVD-ROM sau DVD-R/RW nu citeste un disc sau porneste dupa un timp prea indelungat.

Cauza

Solutie

Suportul a fost introdus invers.

Introduceti din nou suportul cu eticheta in sus.

Unitatea DVD-ROM porneste cu mare intarziere deoarece
trebuie sa determine tipul suportului redat, precum audio sau
video.

Asteptati cel putin 30 de secunde, pentru ca unitatea DVD-
ROM sa determine tipul de suport care urmeaza sa fie redat.
Daca discul inca nu porneste, aplicati alte solutii listate Tn acest
subiect.

Discul CD sau DVD este murdar.

Curatati CD-ul sau DVD-ul cu un set de curatare pentru CD-
uri, disponibil in majoritatea magazinelor care comercializeaza
computere.

Windows nu detecteaza unitatea CD-ROM sau DVD-ROM.

1. Utilizati Device Manager (Manager dispozitive) pentru a
elimina sau a dezinstala dispozitivul.

2. Reporniti computerul si permiteti ca Windows sa
detecteze driverul de CD sau DVD.

inregistrarea sau copierea CD-urilor este dificild sau imposibila.

Cauza

Solutie

Tip de suport incorect sau de calitate slaba.

1. Incercati s utilizati o viteza mai mica pentru inregistrare.
2. Verificati daca utilizati suportul corect pentru unitate.

3. Incercati o altad marca de suport. Calitatea variaza
considerabil de la un fabricant la altul.
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Computerul USDT se incarca prea lent dupa scoaterea unei unitati CD-ROM sau DVD.

Cauza Solutie

Sistemul cauta unitatea in timpul incarcarii, deoarece cablulde Deconectati cablul unitéatii de la placa de sistem.
unitate este Inca atasat la placa de sistem.
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Rezolvarea problemelor legate de Drive Key

Daca intdmpinati probleme legate de Drive Key, cauzele si solutiile uzuale sunt prezentate in tabelul

ROWW

urmator.

Tabelul 2-16 Rezolvarea problemelor legate de Drive Key

Dispozitivul USB Drive Key nu este vazut ca o litera de unitate in Windows.

Cauza

Solutie

Litera de unitate de dupa ultima unitate fizica nu este
disponibila.

Schimbati litera de unitate implicita pentru Drive Key din
Windows.

Dispozitivul USB Drive Key nu a fost gasit (identificat).

Cauza

Solutie

Dispozitivul este atasat la un port USB care a fost ascuns in
Computer Setup.

Executati utilitarul Computer Setup si asigurati-va ca ,Device
available” (Dispozitiv disponibil) este selectat pentru ,All USB
Ports” (Toate porturile USB) si ,,Front USB Ports” (Porturi USB
frontale) sub Security > Device Security ( Securitate -
Securitate dispozitiv).

Dispozitivul nu a fost pozitionat corect inainte de alimentare.

Asigurati-va ca dispozitivul este introdus complet in portul USB
inainte de a aplica alimentarea sistemului

Sistemul nu se incarca din dispozitivul USB Drive Key.

Cauza

Solutie

Ordinea de incarcare nu este corecta.

Executati utilitarul Computer Setup si schimbati secventa de
incarcare in Storage > Boot Order (Stocare-Ordine
incarcare).

Functia Removable Media Boot (Incarcare de pe suporturi
amovibile) este dezactivata in utilitarul Computer Setup.

Executati programul utilitar Computer Setup si activati
fncarcarea pe suporturi amovibile in Storage > Storage
Options (Stocare-Optiuni stocare). Asigurati-va ca USB-ul
este activat in Storage > Boot Order (Stocare — Ordine
fncarcare).

Imaginea de pe dispozitiv nu este incarcabila.

Urmati procedurile descrise in sectiunea ,ROM Flash:
Multiplicarea instalarii: Crearea unui dispozitiv incarcabil:
Dispozitive USB Flash Media acceptate” din manualul Service
Reference Guide (Ghid de referinta service).

Computerul incarca sistemul DOS dupa ce un dispozitiv Drive Key este configurat ca dispozitiv de incarcare.

Cauza

Solutie

Dispozitivul Drive Key este dispozitiv de incarcare.

Instalati dispozitivul Drive Key numai dupa ce se incarca
sistemul de operare.
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Rezolvarea problemelor legate de componentele de pe

panoul frontal

Daca intdmpinati probleme cu dispozitive conectate la panoul frontal, consultati cauzele si solutiile

uzuale listate in tabelul urmator.

Tabelul 2-17 Rezolvarea problemelor legate de componentele de pe panoul frontal

Un dispozitiv USB, castile sau microfonul nu sunt recunoscute de catre computer.

Cauza

Solutie

Dispozitivul nu este conectat corect.

1.

2,

Opriti computerul.

Reconectati dispozitivul in partea frontala a computerului
si reporniti computerul.

Dispozitivul nu este alimentat.

Daca dispozitivul USB necesita alimentare in c.a., asigurati-va
ca un capat este conectat la dispozitiv i un capat este conectat
la o priza functionala.

Nu este instalat driverul de dispozitiv corect. 1. Instalati driverul corect pentru dispozitiv.

2. Este posibil sa fie necesara reincarcarea computerului.
Cablul din dispozitiv spre computer nu lucreaza. 1. Daca este posibil, inlocuiti cablul.

2. Reporniti computerul.
Dispozitivul nu lucreaza. 1. Tnlocuiti dispozitivul.

2. Reporniti computerul.

Porturile USB sunt dezactivate in Computer Setup.

Intrati in Computer Setup (F10) si activati porturile USB.
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Rezolvarea problemelor de acces la Internet

Daca intdmpinati probleme legate de accesul la Internet, consultati Internet Service Provider (ISP)
(Furnizorul de servicii Internet) sau examinati cauzele si solutiile uzuale listate in tabelul urmator.

ROWW

Tabelul 2-18 Rezolvarea problemelor de acces la Internet

Conectarea la Internet nu reuseste.

Cauza

Solutie

Contul furnizorului de servicii Internet (ISP) nu este configurat
corect.

Verificati setarile Internet sau contactati ISP pentru asistenta.

Modemul nu este configurat corect.

Reconectati modemul. Verificati corectitudinea conexiunilor,
utilizénd documentatia pentru configurare rapida.

Browserul Web nu este configurat corect.

Verificati daca browserul Web este instalat si configurat pentru
a functiona cu furnizorul ISP respectiv.

Modemul de cablu/DSL nu este conectat.

Conectati modemul de cablu/DSL. Trebuie sa vedeti un LED
de stare a alimentarii pe partea frontala a modemului de cablu/
DSL.

Serviciul prin cablu/DSL nu este disponibil sau a fost intrerupt
din cauza vremii nefavorabile.

Tncercati s v& conectatila Internet mai tarziu sau luati legatura
cu furnizorul ISP. (Daca serviciul prin cablu/DSL este conectat,
LED-ul de stare a legaturii prin cablu, de pe partea frontala a
modemului, este aprins.)

Cablul UTP CAT5 nu este conectat.

Conectati cablul UTP CATS intre modemul de cablu si
conectorul RJ-45 a computerului. (Cand conexiunea este
buna, LED-ul de stare a legaturii cu PC-ul, de pe partea
frontala a modemului de cablu/DSL, este aprins.)

Adresa IP nu este configurata corect.

Contactati ISP pentru adresa IP corecta.

Modulele cookie sunt corupte. (Un modul ,,cookie” este o
colectie mica de informatii pe care un server Web le poate
depozita temporar cu browserul Web. Acestea sunt utile pentru
ca browserul sa poata memora unele informatii specifice pe
care serverul Web sa le poata prelua ulterior.)

Windows Vista

1. Selectati Start > Control Panel (Panou de control).
Faceti clic pe Network and Internet (Retea si Internet).

3.  Faceti clic pe Internet Options (Optiuni Internet).

4. In sectiunea Browsing history (Istoric navigare) din fila
General, faceti clic pe butonul Delete (Stergere).

5.  Faceti clic pe butonul Delete cookies (Stergere module
cookie).

Windows XP

1. Selectati Start > Control Panel (Start — Panou de
control).

2. Faceti dublu clic pe Internet Options (Optiuni Internet).

3. Infila General, faceti clic pe butonul Delete Cookies
(Stergere module cookie).

Nu se lanseaza automat programele pe Internet.

Cauza

Solutie

Trebuie sa va conectati la ISP Tnainte de a porni programele.

Conectati-va la ISP si lansati programul dorit.
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Tabelul 2-18 Rezolvarea problemelor de acces la Internet (Continuare)

Descarcarea site-urilor Web de pe Internet dureaza prea mulit.

Cauza Solutie

Modemul nu este configurat corect. Verificati daca modemul este conectat i comunica in mod
corespunzator.
Windows XP

1. Selectati Start > Control Panel (Start — Panou de
control).

2. Faceti dublu clic pe System (Sistem).
3. Faceti clic pe fila Hardware.

4. Tn zona Device Manager (Manager dispozitive), faceti
clic pe butonul Device Manager (Manager dispozitive).

5.  Faceti dublu clic pe Modems (Modemuri).

6. Faceti dublu clic pe Agere Systems PCI-SV92PP Soft
Modem.

7. Infila General, faceti clic pe Diagnostics (Diagnostice).

8. Faceti clic pe Query Modem (Interogare modem). Un
raspuns ,Success” (Succes) indica faptul ca modemul
este conectat si functioneaza corespunzator.

Windows Vista

1. Selectati Start > Control Panel (Panou de control).

2. Faceti clic pe System and Maintenance (Sistem si
intretinere).

3. Faceti clic pe System (Sistem).

4. nlista Tasks (Activitati), selectati Device Manager
(Manager dispozitive).

5.  Faceti dublu clic pe Modems (Modemuri).

6. Faceti dublu clic pe Agere Systems PCI-SV92PP Soft
Modem.

7. Infila General, faceti clic pe Diagnostics (Diagnostice).
8. Faceti clic pe Query Modem (Interogare modem). Un

raspuns ,Success” (Succes) indica faptul ca modemul
este conectat si functioneaza corespunzator.
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Rezolvarea problemelor legate de software

Majoritatea problemelor legate de software apar ca rezultat al urmatoarelor situatii:

ROWW

e Aplicatia nu a fost instalata sau configurata corect.

e Nu exista suficientd memorie disponibila pentru executarea aplicatiei.

e  Exista un conflict intre aplicatii.

e Verificati daca au fost instalate toate driverele necesare pentru dispozitive.

e Daca ati instalat un alt sistem de operare decét cel instalat din fabrica, verificati daca acesta este

acceptat de sistem.

Daca intdmpinati probleme legate de software, examinati solutiile aplicabile prezentate in tabelul

urmator.

Tabelul 2-19 Rezolvarea problemelor legate de software

Computerul nu continua si nu a aparut nici un ecran cu sigla HP.

Cauza

Solutie

A survenit o eroare POST.

Observati semnalele sonore si LED-urile de pe panoul frontal
al computerului. Pentru a determina cauzele posibile,
consultati Anexa A, Mesaje de eroare POST, |a pagina 51.

Consultati Restore Kit (Set restaurare) sau Worldwide Limited
Warranty (Certificatul international de garantie limitata), pentru
termeni si conditii.

Computerul nu continua dupa ce a aparut un ecran cu sigla HP.

Cauza

Solutie

Este posibil ca figierele de sistem sa fie deteriorate.

Utilizati o discheta de recuperare pentru a scana unitatea de
disc cu privire la erori.

Se afigeaza mesajul de eroare , lllegal Operation has Occurred” (A survenit o operatie ilegala).

Cauza

Solutie

Software-ul in curs de utilizare nu este autorizat de Microsoft
pentru versiunea dvs. de Windows.

Verificati daca software-ul este autorizat de Microsoft pentru
versiunea dvs. de Windows (examinati pachetul de programe
pentru aceste informatii).

Fisierele de configurare sunt corupte.

Daca este posibil, salvati toate datele, inchideti toate
programele si reporniti computerul.
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Contactarea asistentei pentru clienti

Pentru ajutor si asistenta, contactati un distribuitor autorizat. Pentru a gasi un distribuitor apropiat de
zona in care va aflati, vizitati http://www.hp.com.

B NOTA: Daca duceti computerul la un distribuitor sau furnizor de servicii autorizat pentru service, nu
uitati sa i furnizati parolele de setare si de pornire, daca sunt stabilite.

Pentru asistenta tehnica, apelati numarul corespunzator dintre cele specificate in certificatul de garantie
sau Tn ghidul Support Telephone Numbers (Numere de telefon pentru asistenta).
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Mesaje de eroare POST

Aceasta anexa listeaza codurile de eroare, mesajele de eroare si diversele secvente luminoase si
sonore de indicator pe cale le puteti intalni in timpul testului Power-On Self-Test (POST) sau in timpul
repornirii computerului, sursa probabila a problemei si pasii pe care i puteti urma pentru a rezolva
conditia de eroare.

Post Messages Disabled elimind majoritatea mesajelor de sistem n timpul testelor POST, precum
contorul de memorie si mesajele text care nu semnaleaza erori. Daca survine o eroare POST, ecranul
va afisa mesajul de eroare. Pentru a comuta manual in modul Post Messages Enabled in timpul testelor
POST, apasati orice tasta (cu exceptia tastelor F10 sau F12). Modul de setare implicit este POST
Message Disabled.

Viteza cu care computerul incarca sistemul de operare si extensia la care acesta este testat sunt
determinate de selectia modului POST.

Quick Boot (Incarcare rapida) este un proces de pornire rapida care nu executa toate testele de nivel
de sistem, precum testul de memorie. Full Boot (Incarcare completa) executa toate testele de sistem
pe baza de ROM si necesitda mai mult timp pentru finalizare.

Full Boot (Incarcare completa) se poate activa si pentru a se executa dupa fiecare interval de la 1 la 30
de zile, pe baza unei programari efectuate cuhregularitate. Pentru a stabili programarea, reconfigurati

computerul in modul Full Boot Every x Days (Incarcare completa la fiecare x zile), utilizand Computer
Setup.

Ef NOTA: Pentru informatii suplimentare despre programul Computer Setup, consultati Computer Setup
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(F10) Utility Guide (Ghidul programului utilitar Computer Setup (F10)).
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Coduri numerice POST si mesaje text

Aceasta sectiune acopera acele erori POST care au coduri numerice asociate. Sectiunea mai include
unele mesaje text care pot fi intalnite in timpul testelor POST.

B NOTA: Computerul va emite un semnal sonor dupa ce pe ecran este afisat un mesaj text POST.

Tabelul A-1 Coduri numerice si mesaje text

Mesaj pe panoul de control Descriere Actiune recomandata

101-Option ROM Checksum Error (101- Suma de control pentru memoria ROM de 1. Verificati memoria ROM corecta.

Eroare suma de control memorie ROM sistem sau pentru memoria ROM optionala

optionala) de pe placa de extensie. 2. Curatati memoria ROM, daca este
necesar.

3. Daca a fost adaugata recent o placa de
extensie, inlaturati-o, pentru a constata
daca problema persista.

4. Goliti CMOS. (Consultati Anexa B,
Securitatea prin parola si resetarea
CMOS, la pagina 62.)

5. Daca mesajul dispare, este posibil sa fie
o problema cu placa de extensie.

6. Tnlocuiti placa de sistem.

103-System Board Failure (103 — Defectiune DMA sau temporizatoare. 1.  Goliti CMOS. (Consultati Anexa B,
placa de sistem) Securitatea prin parola si resetarea
CMQOS, la pagina 62.)

2. Scoateti placile de extensie.

3. nlocuiti placa de sistem.

110-Out of Memory Space for Option ROMs  Placa de extensie PCI recent adaugata 1. Daca a fost adaugata recent o placa de
(110-Spatiu de memorie insuficient pentru contine o memorie ROM optionala prea mare extensie PCI, inlaturati-o, pentru a
memoriile ROM optionale) pentru descarcare in timpul testelor POST. constata daca problema persista.

2. Tn Computer Setup, setati Advanced >
Device Options > NIC PXE Option
ROM Download (Avansat — Optiuni
dispozitive - Descarcare memorie ROM
optionala NIC PXE) la DISABLE
(DEZACTIVARE), pentru a impiedica ca
n timpul testelor POST sa fie
descarcata memoria ROM optionala
PXE pentru NIC intern, cu scopul de a
elibera mai multda memorie pentru o
memorie ROM optionala a placii de
extensie. Memoria ROM optionala PXE
interna se utilizeaza pentru incarcarea
din NIC intr-un server PXE.

3. Asigurati-va ca setarea ACPI/USB
Buffers @ Top of Memory (Zone tampon
ACPI/USB si zona superioara a
memoriei) din Computer Setup este

activata.
162-System Options Not Set (162-Nu sunt Configuratie incorecta. Executati programul Computer Setup si
setate optiuni de sistem) verificati configuratia din Advanced >
Este posibil sa fie necesara inlocuirea Onboard Devices (Avansat - Dispozitive
bateriei RTC (real-time clock — ceas in timp  montate pe placa de sistem).

real).
Resetati data si ora sub Control Panel
(Panou de control). Daca problema persista,
nlocuiti bateria RTC. Pentru instructiuni
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Tabelul A-1 Coduri numerice si mesaje text (Continuare)

Mesaj pe panoul de control

Descriere

Actiune recomandata

despre instalarea unei baterii noi, consultati
Hardware Reference Guide (Ghid de
referintd hardware) sau contactati un dealer
sau un revanzator autorizat pentru inlocuirea
bateriei RTC.

163-Time & Date Not Set (163-Nu sunt setate
data si ora)

Ora dau data sunt incorecte Tn memoria de
configuratie.

Este posibil sa fie necesara inlocuirea
bateriei RTC (real-time clock — ceas in timp
real).

Resetati data si ora din Control Panel
(Panou de control) — se poate utiliza si
programul Computer Setup. Daca problema
persista, inlocuiti bateria RTC. Pentru
instructiuni despre instalarea unei baterii noi,
consultati Hardware Reference Guide (Ghid
de referintd hardware) sau contactati un
dealer sau un revanzator autorizat pentru
nlocuirea bateriei RTC.

163-Time & Date Not Set (163-Nu sunt setate
data si ora)

Este posibil ca jumperul CMOS sa nu fie
instalat corect.

Daca este posibil, verificati amplasarea
corecta a jumprului CMOS.

164-MemorySize Error (164-Eroare de
dimensiune a memoriei)

A fost modificata valoarea memoriei in
perioada de dupa ultima incarcare (memorie
adaugata sau eliminata) added or removed).

Apasati tasta F1 pentru a salva modificarile
de memorie.

164-MemorySize Error (164-Eroare de
dimensiune a memoriei)

Configuratia de memorie este incorecta.

1. Executati Computer Setup sau
programe utilitare Windows.

2. Verificati daca modulele de memorie
sunt instalate corect.

3. Daca a fost adaugata memorie de la alti
furnizori, testati utilizand numai
memorie HP.

4. Verificati daca este corect tipul
modulului de memorie.

201-Memory Error (201- Eroare de memorie)

Defectiune RAM.

1.  Executati Computer Setup sau
programe utilitare Windows.

2. Asigurati-va ca modulele de memorie
sunt instalate corect.

3. Verificati daca este corect tipul
modulului de memorie.

4. Scoateti si inlocuiti modulele de
memorie identificate ca fiind defecte.

5. Daca eroarea persista dupa inlocuirea
modulelor de memorie, inlocuiti placa
de sistem.

213-Incompatible Memory Module in
Memory Socket(s) X, X,... (213- Modul de
memorie incompatibil in soclurile de memorie
X, X, ...)

Un modul de memorie din soclul de memorie
identificat In mesajul de eroare are lipsa
informatii SPD critice sau este incompatibil cu
setul de circuite integrate.

1. Verificati daca este corect tipul
modulului de memorie.

2. Incercati alt soclu de memorie.

3. nlocuiti modulul DIMM cu un modul
care corespunde standardului SPD.

214-DIMM Configuration Warning (214-
Avertisment configuratie DIMM)

Configuratia modulelor DIMM incércate nu
este optimizata.

Aranjati din nou modulele DIMM, astfel incat
fiecare canal sa aiba aceeasi cantitate de
memorie.
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Tabelul A-1 Coduri numerice si mesaje text (Continuare)

Mesaj pe panoul de control

Descriere

Actiune recomandata

219-ECC Memory Module Detected ECC
Modules not supported on this Platform (219-
Module ECC detectate ca module de
memorie ECC nu sunt acceptate pe aceasta
platforma)

Modulele de memorie recent adaugate

accepta corectie de eroare de memorie ECC.

1. Daca a fost adaugata recent o memorie
suplimentara, inlaturati-o, pentru a
constata daca problema persista.

2. Examinati documentatia produsului
pentru informatii despre capacitatea de
memorie.

301-Keyboard Error (301- Eroare tastatura)

Tastatura defecta.

1. Reconectati tastatura cadnd computerul
este oprit.

2. Verificati conectorul pentru a vedea
daca are pini indoiti sau pini lipsa.

3. Asigurati-va ca toate tastele sunt pe
pozitia normala.

4. Tnlocuiti tastatura.

303-Keyboard Controller Error (303-Eroare
controler tastatura)

Controler tastatura placa I/0.

1. Reconectati tastatura cand computerul
este oprit.

2. nlocuiti placa de sistem.

304-Keyboard or System Unit Error (304-
Eroare tastatura sau unitate de sistem)

Tastatura defecta.

1. Reconectati tastatura cand computerul
este oprit.

2. Asigurati-va ca toate tastele sunt pe
pozitia normala.

3. Tnlocuiti tastatura.

4. Tnlocuiti placa de sistem.

404-Parallel Port Address Conflict Detected
(404-S-a detectat un conflict de adrese de
port paralel)

Atat portul extern cat si cel intern sunt
asociate la portul paralel X.

1.  Scoateti placile de extensie de port
paralel.

2. Goliti CMOS. (Consultati Anexa B,
Securitatea prin parola si resetarea
CMQS, la pagina 62.)

3. Reconfigurati resursele de placa si/sau
executati Computer Setup.

410-Audio Interrupt Conflict (410-Conflict
intrerupere audio)

Conflicte de adresa IRQ cu alt dispozitiv.

Introduceti programul Computer Setup si
resetati IRQ din Advanced > Onboard
Devices (Avansat - Dispozitive montate pe
placa de sistem).

411-Network Interface Card Interrupt Conflict
(411-Conflict intrerupere placa interfata
retea)

Conflicte de adresa IRQ cu alt dispozitiv.

Introduceti programul Computer Setup si
resetati IRQ din Advanced > Onboard
Devices (Avansat - Dispozitive montate pe
placa de sistem).

501-Display Adapter Failure (501-Defectiune
adaptor afisaj)

Controler afisare grafica.

1. Repozitionati placa grafica (daca este
posibil).

2. Goliti CMOS. (Consultati Anexa B,
Securitatea prin parola si resetarea
CMOS, la pagina 62.)

3. Verificati daca monitorul este atasat si
pornit.

4. Tnlocuiti placa grafica (daca este
posibil).

510-Flash Screen Image Corrupted (510-
Imaginea de ecran flash este corupta)

Imaginea de ecran flash are erori.

Curatati din nou memoria ROM a sistemului,
cu cea mai recenta imagine BIOS.
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Tabelul A-1 Coduri numerice si mesaje text (Continuare)

Mesaj pe panoul de control

Descriere

Actiune recomandata

Nu s-a detectat ventilator 511-CPU, CPUA
sau CPUB

Ventilatorul CPU nu este conectat sau
functioneaza necorespunzator.

1. Repozitionati ventilatorul CPU.
2. Repozitionati cablul ventilatorului.

3. nlocuiti ventilatorul CPU.

512-Chassis, Rear Chassis, or Front Chassis
Fan not Detected (512-Nu s-a detectat
ventilator de sasiu, de sasiu din spate sau de
sasiu frontal)

Ventilatorul de sasiu, de sasiu din spate sau
de sasiu frontal nu este conectat sau
functioneaza necorespunzator.

1. Repozitionati ventilatorul de sasiu, de
sasiu din spate sau de sasiu frontal.

2. Repozitionati cablul ventilatorului.

3. Tnlocuiti ventilatorul de sasiu, de sasiu
din spate sau de sasiu frontal.

514-CPU or Chassis Fan not Detected (514-
Nu s-a detectat ventilator CPU sau de sasiu)

Ventilatorul CPU sau de sasiu nu este
conectat sau functioneaza necorespunzator.

1. Repozitionati ventilatorul CPU sau de
sasiu.

2. Repozitionati cablul ventilatorului.

3. nlocuiti ventilatorul CPU sau de sasiu.

601-Diskette Controller Error (601-Eroare
controler discheta)

Circuit incorect al controlerului de discheta
sau al unitatii de discheta.

1. Executati Computer Setup.
2. Verificati si /sau Tnlocuiti cablurile.

3. Goliti CMOS. (Consultati Anexa B,
Securitatea prin parola si resetarea
CMOS, la pagina 62.)

4. Tnlocuiti unitatea de discheta.

5. nlocuiti placa de sistem.

605-Diskette Drive Type Error (605-Eroare
tip de unitate discheta)

Nepotrivire la tipul de unitate.

1. Executati Computer Setup.

2. Deconectati orice alte dispozitive
controler de discheta (unitati cu banda).

3. Goliti CMOS. (Consultati Anexa B,
Securitatea prin parola si resetarea
CMOS, la pagina 62.)

610-External Storage Device Failure (610-
Dispozitiv de stocare extern defect)

Nu este conectata o unitate cu banda
externa.

Reinstalati unitatea cu banda sau apasati
F1 si permiteti sistemului sa reconfigureze
fara unitate.

611-Primary Floppy Port Address
Assignment Conflict (611-Conflict de
asociere adrese port discheta principal)

Eroare de configuratie.

Executati programul Computer Setup si
verificati configuratia din Advanced >
Onboard Devices (Avansat - Dispozitive
montate pe placa de sistem).

660-Display cache is detected unreliable
(660-Memoria cache de afisaj este detectata
ca fiind nefiabild)

Memoria cache de afisaj controler placa
grafica integrata nu lucreaza corespunzator
si va fi dezactivata.

Tnlocuiti placa de sistem daca degradarea
minimala a placii grafice este o problema.

912-Computer Cover Has Been Removed
Since Last System Startup (912-Capacul
computerului a fost scos in perioada de dupa
ultima pornire a sistemului)

Capacul computerului a fost scos in perioada
de dupa ultima pornire a sistemului.

Nu este necesara nici o actiune.

917-Front Audio Not Connected (917-
Sistemul audio frontal nu este conectat)

Firele sistemului audio frontal au fost
detasate sau au fost deranjate din pozitia
corecta de la placa de baza.

Reconectati sau inlocuiti firele sistemului
audio frontal.

918-Front USB Not Connected (918-Portul
USB frontal nu este conectat)

Firele portului USB frontal au fost detasate
sau au fost deranjate din pozitia corecta de la
placa de baza.

Reconectati sau inlocuiti firele portului USB
frontal.
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Tabelul A-1 Coduri numerice si mesaje text (Continuare)

Mesaj pe panoul de control

Descriere

Actiune recomandata

921-Device in PCI Express slot failed to
initialize (Nu a reusit initializarea
dispozitivului din slotul PCI Express)

Exista o incompatibilitate/problema cu acest
dispozitiv, iar legatura cu sistemul sau PCI
Express nu se poate realiza printr-un slot x1.

Tncercati s incarcati sistemul din nou. Dacé
eroarea apare din nou, este posibil ca
dispozitivul sa nu functioneze cu acest sistem

1151-Serial Port A Address Conflict Detected
(1151-S-a detectat un conflict de adrese la
portul serial A)

Atat portul serial extern cat si cel intern sunt
asociate la COM1.

1.  Scoateti placile de extensie de port
serial.

2. Goliti CMOS. (Consultati Anexa B,
Securitatea prin parola si resetarea
CMOS, la pagina 62.)

3. Reconfigurati resursele de placa si/sau
executati Computer Setup sau utilitare
Windows.

1152-Serial Port B Address Conflict Detected
(1152-S-a detectat un conflict de adrese la
portul serial B)

Atat portul serial extern cat si cel intern sunt
asociate la COM2.

1.  Scoateti placile de extensie de port
serial.

2. Goliti CMOS. (Consultati Anexa B,
Securitatea prin parola si resetarea
CMQOS, la pagina 62.)

3. Reconfigurati resursele de placa si/sau
executati Computer Setup sau utilitare
Windows.

1155-Serial Port Address Conflict Detected
(1155-S-a detectat un conflict de adrese la
portul serial)

Atat portul serial extern cat si cel intern sunt
asociate la acelasi IRQ.

1.  Scoateti placile de extensie de port
serial.

2. Goliti CMOS. (Consultati Anexa B,
Securitatea prin parola si resetarea
CMOQOS, la pagina 62.)

3. Reconfigurati resursele de placa si/sau
executati Computer Setup sau utilitare
Windows.

1201-System Audio Address Conflict
Detected (1201-S-a detectat un conflict de
adrese la placa audio de sistem)

Conflicte de adresa IRQ a dispozitivului cu alt
dispozitiv.

Introduceti programul Computer Setup si
resetati IRQ din Advanced > Onboard
Devices (Avansat - Dispozitive montate pe
placa de sistem).

1202-MIDI Port Address Conflict Detected
(1202-S-a detectat un conflict de adrese la
portul MIDI)

Conflicte de adresa IRQ a dispozitivului cu alt
dispozitiv.

Introduceti programul Computer Setup si
resetati IRQ din Advanced > Onboard
Devices (Avansat - Dispozitive montate pe
placa de sistem).

1203-Game Port Address Conflict Detected
(1203-S-a detectat un conflict de adrese la
portul de jocuri)

Conflicte de adresa IRQ a dispozitivului cu alt
dispozitiv.

Introduceti programul Computer Setup si
resetati IRQ din Advanced > Onboard
Devices (Avansat - Dispozitive montate pe
placa de sistem).

1720-SMART Hard Drive Detects Imminent
Failure (1720-Unitatea de disc SMART
detecteaza un defect iminent)

Unitatea de disc este pe cale sa se defecteze.
(Unele unitati de disc au o corectie de
firmware de pe unitatea de disc care va
repara un mesaj de eroare eronat.)

1. Determinati daca unitatea de disc da
mesaj de eroare corect. Introduceti
Computer Setup si executati testul Drive
Protection System (DPS) sub Storage
> DPS Self-test (Stocare - Testare
automata DPS).

2. Daca este cazul, aplicati corectia de
firmware de pe unitatea de disc.
(Disponibil la http://www.hp.com/
support.)

3. Faceti o copie de rezerva a continutului
si inlocuiti unitatea de disc.

1796-SATA Cabling Error (1796-Eroare de
cablu SATA)

Unul sau mai multe dispozitive SATA sunt
atagate incorect. Pentru performante optime,

Asigurati-va ca conectorii SATA sunt utilizati
n ordine crescatoare. Pentru un dispozitiv,
utilizati SATAO. Pentru doua dispozitive,
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Tabelul A-1 Coduri numerice si mesaje text (Continuare)

Mesaj pe panoul de control Descriere

Actiune recomandata

conectorii SATAO si SATA1 trebuie sa fie
utilizati inainte de SATA2 si SATA3.

utilizati SATAO si SATA1. Pentru trei
dispozitive, utilizati SATAO, SATA1 si
SATA2.

1797-SATA Drivelock is not supported in Caracteristica Drivelock este activata pe una
RAID mode (1797- SATA Drivelock nu este  sau mai multe unitati de disc SATA si nu se
acceptat in mod RAID). poate accesa in timp ce sistemul este

configurat pentru modul RAID.

Fie scoateti dispozitivul SATA pe care este
activata caracteristica Drivelock, fie
dezactivati caracteristica Drivelock. Pentru a
dezactiva caracteristica Drivelock, introduceti
Computer Setup, schimbati Storage >
Storage Options > SATA Emulation
(Stocare — Optiuni de stocare - Emulare
SATA) in IDE si selectati File > Save
Changes and Exit (Fisier - Salvare
modificari si iesire). Reintroduceti Computer
Setup si selectati Security > Drivelock
(Securitate — Drivelock). Pentru fiecare
dispozitiv listat SATA capabil sa utilizeze
Drivelock, asigurati-va c& Drivelock este
Disabled (Dezactivat). in sfarsit, schimbati
Storage > Storage Options > SATA
Emulation (Stocare — Optiuni de stocare -
Emulare SATA) inapoi in RAID si selectati
File > Save Changes and Exit (Fisier -
Salvare modificari si iegire).

1801-Microcode Patch Error (1801-Eroare Procesorul nu este acceptat de ROM BIOS.
corectie Microcode)

1. Faceti upgrade la BIOS pentru o
versiune corespunzatoare.

2. Schimbati procesorul.

2200-PMM Allocation Error during MEBx Eroare de memorie in timpul executarii POST
Download (2200-Eroare de alocare in timpul a memoriei optionale ROM de extensie BIOS

1. Reincarcati computerul.

descarcarii MEBx) pentru Management Engine (ME) (Motor de 2.  Decuplati cablul de alimentare,
gestionare) repozitionati modulele de memorie i
reincarcati computerul.

3. Daca configuratia memoriei a fost
modificata recent, deconectati
computerul, restaurati configuratia
initiala a memoriei si reincarcati
computerul.

4. Daca eroarea persista, inlocuiti placa de
sistem.

2201-MEBx Module did not checksum Eroare de memorie in timpul executarii POST 1. Reincarcati computerul.

correctly (2201-Modulul MEBXx nu realizeaza a memoriei optionale ROM de extensie BIOS

corect suma de control) pentru Management Engine (ME) (Motor de 2. Decuplati cablul de alimentare,
gestionare) repozitionati modulele de memorie si

reincarcati computerul.

3. Daca configuratia memoriei a fost
modificata recent, deconectati cablul de
alimentare, restaurati configuratia
initiala a memoriei si reincarcati
computerul.

4. Daca eroarea persista, inlocuiti placa de
sistem.

2202-PMM Deallocation Error during MEBx  Eroare de memorie in timpul executarii POST

cleanup (2202-Eroare de dezalocare in a memoriei optionale ROM de extensie BIOS
timpul curatarii MEBXx) pentru Management Engine (ME) (Motor de
gestionare)

1. Reincarcati computerul.

2. Decuplati cablul de alimentare,
repozitionati modulele de memorie si
reincarcati computerul.

3. Daca configuratia memoriei a fost
modificata recent, deconectati cablul de
alimentare, restaurati configuratia
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Tabelul A-1 Coduri numerice si mesaje text (Continuare)

Mesaj pe panoul de control

Descriere

Actiune recomandata

initiala a memoriei gi reincarcati
computerul.

4. Daca eroarea persista, inlocuiti placa de
sistem.

2203-Setup error during MEBXx execution Selectarea sau iesirea din MEBx au avutca 1.  Reincarcati computerul.

(2203-Eroare de setare in timpul executarii rezultat un esec de setare.

MEBX) 2. Decuplati cablul de alimentare,
repozitionati modulele de memorie si
reincarcati computerul.

3. Daca configuratia memoriei a fost
modificata recent, deconectati cablul de
alimentare, restaurati configuratia
initialda a memoriei si reincarcati
computerul.

4. Daca eroarea persista, inlocuiti placa de
sistem.

2204-Inventory error during MEBXx execution Informatiile BIOS trecute la MEBx au avutca 1. Reincarcati computerul.

(2204-Eroare de inventariere in timpul rezultat un esec.

executarii MEBXx) 2. Daca eroarea persista, faceti o
actualizare la cea mai recenta versiune
BIOS.

3. Daca eroareainca mai persista, inlocuiti
placa de sistem.

2205-Interface error during MEBXx execution Operarea MEBx a intdampinat o eroare 1. Reincarcati computerul.

(2205-Eroare de interfata in timpul executarii hardware in timpul comunicatiei cu ME.

MEBX) 2. Daca eroarea persista, faceti o
actualizare la cea mai recenta versiune
BIOS.

3. Daca eroarea inca mai persista, inlocuiti

placa de sistem.

2211-Memoria nu este corect configurata

pentru executarea corespunzatoare a
utilitarului MEBx.

Soclul DIMM1 nu este instalat.

Asigurati-va ca este instalat un modul de
memorie Tn soclul negru DIMM1 si ca este
asezat corect pe pozitie.

Invalid Electronic Serial Number (Numar de

Numarul de serie electronic lipseste.

Introduceti numarul de serie corect in

serie electronic incorect) Computer Setup.
Network Server Mode Active and No Defectiune de tastatura in timp ce 1. Reconectati tastatura cand computerul
Keyboard Attached (Caracteristica Network  caracteristica Network Server Mode (Mod este oprit.
Server Mode (Mod server de retea) activa si  server de retea) este activata.
nici o tastatura atagata) 2. Verificati conectorul pentru a vedea
daca are pini indoiti sau pini lipsa.
3. Asigurati-va ca toate tastele sunt pe
pozitia normala.
4. Tnlocuiti tastatura.
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Tabelul A-1 Coduri numerice si mesaje text (Continuare)

Mesaj pe panoul de control Descriere Actiune recomandata

Parity Check 2 (Verificare paritate 2) Defectiune RAM paritate. Executati Computer Setup si programe
utilitare Diagnostic (Diagnosticare).

System will not boot without fan (Sistemul nu  Ventilatorul CPU nu a fost instalat sau a fost 1.  Scoateti capacul computerului, apasati

se va incarca fara ventilator) deconectat din sasiul VSFF. butonul de alimentare si verificati daca
ventilatorul procesorului se roteste.
Daca ventilatorul procesorului nu se
roteste, verificati modul de conectare a
cablului ventilatorului la placa de sistem.
Verificati daca radiatorul este instalat gi
pozitionat corect.

2. Daca ventilatorul este conectat si
radiatorul este pozitionat corect, dar
ventilatorul nu se roteste, atunci inlocuiti
ansamblul radiator-ventilator.
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Interpretarea codurilor de diagnosticare de LED-uri si a
codurilor de diagnosticare sonore de la panoul frontal
POST

Aceasta sectiune trateaza codurile LED-urilor de pe panoul frontal si codurile sonore care pot surveni
fnaintea sau in timpul testelor POST carora nu le este asociat neaparat un cod de eroare sau un mesaj
text.

A AVERTISMENT! Cand computerul este conectat la o sursa de curent alternativ, la placa de sistem se
aplica intotdeauna o tensiune. Pentru a reduce riscul de ranire din cauza socurilor electrice si/sau a
suprafetelor fierbinti, decuplati cablul de alimentare de la priza si asteptati pana cand componentele
interne ale sistemului se racesc, inainte de a le atinge.

2% NOTA: Daca pe o tastatura PS/2 observati LED-uri care clipesc, cautati LED-urile care clipesc pe
panoul frontal al computerului si consultati tabelul de mai jos pentru a determina codul asociat
acestora.

Actiunile recomandate din tabelul de mai jos sunt listate in ordinea n care trebuie efectuate.

Pe unele modele nu sunt disponibile toate codurile luminoase de diagnosticare si toate codurile sonore
de diagnosticare.

Activitate Cauza posibila Actiune recomandata

LED-ul de alimentare este aprins ~ Computer pornit. None (Fara)

verde.

Ledul verde de alimentare clipeste Protectia termica a 1. Verificati daca orificiile de ventilatie ale

o data pe secunda. procesorului este activata: computerului nu sunt blocate si daca ventilatorul de

racire a procesorului functioneaza.
Un ventilator este blocat sau

nu se roteste. 2. Deschideti capacul, apasati butonul de alimentare
si verificati daca ventilatorul procesorului se roteste.

SAU Daca ventilatorul procesorului nu se roteste,
verificati daca este conectat corect cablul

Ansamblul radiator/ventilator ventilatorului la placa de sistem. Verificati daca

nu este atasat corect la ventilatorul este instalat sau pozitionat complet/

procesor. corect.

AVERTISMENT! Elicea rotativa a ventilatorului
poate cauza raniri grave. Aveti grija sa nu atingeti
cu mainile elicea rotativa.

3. Daca ventilatorul este conectat si pozitionat corect,
dar nu se roteste, inlocuiti ventilatorul procesorului.

4. Repozitionati radiatorul procesorului si verificati
daca ansamblul ventilatorului este atasat corect.

5. Contactati un distribuitor sau furnizor de servicii
autorizat.

Ledul verde de alimentare clipeste Computerul este in modul de  Apasati pe orice tasta sau miscati mouse—ul pentru a

de doua ori pe secunda. suspendare in memoria RAM  porni computerul.

sau in modul normal de

suspendare.
Ledul verde de alimentare clipeste Eroare inaintea memoriei ATENTIE: Pentru a evita deteriorarea modulelor DIMM
de cinci ori, o data pe secunda, video. sau a placii de sistem, trebuie sa decuplati cablul de
dupa care urmeaza un semnal alimentare a computerului, inainte de a incerca sa
sonor scurt. repozitionati, sa instalati sau sa scoateti un modul DIMM.

1. Repozitionati modulele DIMM.

2. Pentru aidentifica modulul defect, inlocuiti pe rand
modulele DIMM.
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Activitate

Cauza posibila

Actiune recomandata

3. Tnlocuiti memoria de la alti furnizori cu memorie de
la HP.

4. Tnlocuiti placa de sistem.

Ledul verde de alimentare clipeste
de sase ori, 0 data pe secunda,
dupa care urmeaza un semnal
sonor lung si doua scurte.

Eroare inainte de placa grafica
video.

Pentru sistemele cu o placa grafica:
1. Repozitionati placa grafica.

2. Tnlocuiti placa grafica.

3. nlocuiti placa de sistem.

Pentru sistemele cu placa grafica integrata, inlocuiti
placa de sistem.

Ledul verde de alimentare clipeste
de opt ori, 0 data pe secunda, dupa
care urmeaza doua semnale
sonore scurte.

Memorie ROM nevalida cu
unitate de discheta.

1. Curatati din nou memoria ROM a sistemului, cu cea
mai recenta imagine BIOS.

2. Tnlocuiti placa de sistem.

Ledul verde de alimentare clipeste
de opt ori, 0 data pe secunda, dupa
care urmeaza doua semnale
sonore scurte, apoi succesive.

Memorie ROM nevalida fara
unitate de discheta.

1. Conectati unitatea de discheta si curatati din nou
memoria ROM a sistemului.

2. Actualizati din nou memoria ROM a sistemului cu
cea mai recenta imagine BIOS.

3. Tnlocuiti placa de sistem.

Interpretarea codurilor de diagnosticare de LED-uri si a codurilor de diagnosticare sonore dela 61
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B Securitatea prin parola si resetarea
CMOS

Acest computer accepta caracteristici de parola pentru securitate, care se pot stabili prin meniul
programelor utilitare Computer Setup.

Acest computer accepta doua caracteristici de parola pentru securitate, care sunt stabilite prin meniul
programelor utilitare Computer Setup: parola de setare gi parola de pornire. Cand stabiliti numai parola
de setare, orice utilizator poate accesa toate informatiile de pe computer cu exceptia celor din Computer
Setup. Cand stabiliti numai o parola de pornire, parola de pornire este necesara pentru a accesa
Computer Setup si orice alte informatii de pe computer. Cand stabiliti ambele parole, numai parola de
setare va va oferi acces la Computer Setup.

Cand sunt setate ambele parole, parola de setare se poate utiliza in locul parolei de pornire, ca o
ignorare, pentru conectarea la computer. Aceasta este o caracteristica utila pentru un administrator de
retea.

Daca ati uitat parola pentru computer, se poate sterge parola, astfel incat sa obtineti acces la informatiile
din computer prin resetarea jumperului de parola.

A ATENTIE: Prin apdsarea butonului CMOS, se vor reseta valorile CMOS la valorile implicite de fabrica.
nainte de a reseta CMOS, pentru cazul in care va fi nevoie ulterior de setérile actuale, este important
sa faceti o copie de rezerva a setarilor CMOS ale computerului. Copierea de rezerva este simplu de
efectuat prin Computer Setup. Pentru informatii suplimentare despre efectuarea unei copii de rezerva
a setarilor CMOS, consultati Computer Setup (F10) Utility Guide (Ghidul programului utilitar Computer
Setup (F10)).
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Resetarea jumperului de parola

Pentru a dezactiva caracteristicile parolei de pornire sau de setare, sau pentru a goli parolele de pornire
sau de setare, finalizati urmatorii pasi:

1. Opriti corect sistemul de operare, opriti computerul si toate dispozitivele externe, apoi deconectati
cablul de alimentare de la priza de alimentare.

2. Cu cablul de alimentare deconectat, apasati din nou butonul de alimentare, pentru a goli sistemul
alimentarilor reziduale.

/A AVERTISMENT! Pentru a reduce riscul de ranire din cauza socurilor electrice si/sau a
suprafetelor fierbinti, decuplati cordonul de alimentare de la priza si asteptati pana cand
componentele interne ale sistemului se racesc, inainte de a le atinge.

A ATENTIE: Cand computerul este conectat, sursa de alimentare are intotdeauna tensiune
aplicata la placa de sistem, chiar cand unitatea este oprita. O eroare la deconectarea cablului de
alimentare poate avea ca rezultat defectarea sistemului.

Electricitatea statica poate sa deterioreze componentele electronice ale computerului sau
echipamentele optionale. nainte de a incepe aceste proceduri, aveti grija sa va descarcati de
electricitatea statica atingédnd un obiect metalic legat la pamant. Pentru mai multe informatii,
consultati ghidul Safety & Regulatory Information (Informatii despre norme si despre siguranta).

3. Scoateti capacul computerului sau panoul de acces de la computer.

4. Localizati blocul de pini si jumperul.

Er NOTA: Jumperul de parola este verde, astfel incat este usor de identificat. Pentru a fi indrumat
in localizarea jumperului de parola sau a altor componente ale placii de sistem, consultati lllustrated
Parts Map (IPM) (Schema ilustrata a pieselor) pentru acest sistem particular. IPM se poate
descarca din http://www.hp.com/support.

5. Scoateti jumperul din pinii 1 si 2. Plasati jumperul fie in pinul 1, fie in pinul 2, dar nu in ambele,
astfel incat sa nu se piarda.

6. Punetila loc capacul sau panoul de acces la computer.
7. Reconectati echipamentul extern.

8. Conectati computerul si porniti calculatorul. Permiteti sistemului de operare sa porneasca. Acesta
sterge parolele curente si dezactiveaza caracteristicile de parola.

9. Pentru a stabili noile parole, repetati pasii de la 1 la 4, puneti la loc jumperul de parola pe pinii 1 si
2, apoi repetati pasii de la 6 la 8. Stabiliti noile parole in Computer Setup. Pentru informatii
suplimentare cu privire la utilizarea programului Computer Setup, consultati Computer Setup (F10)
Utility Guide (Ghidul programului utilitar Computer Setup (F10)).
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Stergerea si resetarea CMOS

Memoria de configurare a computerului (CMOS) stocheaza informatii despre configuratia computerului.

Butonul CMOS reseteaza CMOS dar nu sterge parolele de pornire si de setare.

Stergerea CMOS va duce la stergerea setarilor Active Management Technology (AMT) - Tehnologie
de gestionare activa din Management Engine BIOS Extension (MEBX) - Executie BIOS a motorului de
gestionare, inclusiv a parolei. Parola va reveni la ,admin” si va fi necesar sa fie resetata. De asemenea,
setarile AMT vor trebui resetate. Pentru a accesa MEBX, apasati CTRL+P de la tastatura, in timpul
testelor POST.

1.

Deconectati computerul si toate dispozitivele externe si deconectati cablul de alimentare de la priza
de alimentare.

Deconectati tastatura, monitorul si toate celelalte echipamente externe conectate la computer.

AVERTISMENT! Pentru a reduce riscul de ranire din cauza socurilor electrice si/sau a
suprafetelor fierbinti, decuplati cordonul de alimentare de la priza si asteptati pana cand
componentele interne ale sistemului se racesc, inainte de a le atinge.

ATENTIE: Cand computerul este conectat, sursa de alimentare are intotdeauna tensiune
aplicata la placa de sistem, chiar cand unitatea este oprita. O eroare la deconectarea cablului de
alimentare poate avea ca rezultat defectarea sistemului.

Electricitatea statica poate sa deterioreze componentele electronice ale computerului sau
echipamentele optionale. inainte de a incepe aceste proceduri, aveti grija s& va descarcati de
electricitatea statica atingdnd un obiect metalic legat la pamént. Pentru mai multe informatii,
consultati ghidul Safety & Regulatory Information (Informatii despre norme si despre siguranta).

Scoateti capacul computerului sau panoul de acces de la computer.

ATENTIE: Prin apasarea butonului CMOS, se vor reseta valorile CMOS la valorile implicite de
fabrica. Tnainte de a reseta CMOS, pentru cazul in care va fi nevoie ulterior de setérile actuale,
este important sa faceti o copie de rezerva a setarilor CMOS ale computerului. Copierea de rezerva
este simplu de efectuat prin Computer Setup. Pentru informatii suplimentare despre efectuarea
unei copii de rezerva a setarilor CMOS, consultati Computer Setup (F10) Utility Guide (Ghidul
programului utilitar Computer Setup (F10)).
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4. Localilzati, apasati si tineti apasat butonul CMOS timp de cinci secunde.

Ef NOTA: Asigurati-va ca ati deconectat cablul de alimentare cu c.a. din priza de perete. Butonul
CMOS nu va goli CMOS atata timp cat cablul de alimentare este conectat.

Figura B-1 Butonul CMOS

B NOTA: Pentru a fi indrumat in localizarea butonului CMOS sau a altor componente ale plécii de
sistem, consultati lllustrated Parts Map (IPM) (Schema ilustrata a pieselor) pentru acest sistem
particular.

5. Puneti la loc capacul sau panoul de acces la computer.
6. Reconectati dispozitivele externe.

7. Conectati computerul si porniti calculatorul.

Ef NOTA: Dupa golirea CMOS si reincarcare, veti primi un mesaj de eroare POST, care va va
avertiza daca au survenit modificari de configuratie. Utilizati Computer Setup pentru a reseta orice
setare speciala de sistem, impreuna cu data si ora.

Pentru informatii suplimentare cu privire la utilizarea programului Computer Setup, consultati Computer
Setup (F10) Utility Guide (Ghidul programului utilitar Computer Setup (F10)).
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C Drive Protection System (DPS) (Sistem
de protectie a unitatilor)

Sistemul de protectie a unitatilor (DPS) este un instrument de diagnosticare incorporat in unitatile de
disc instalate la unele computere. Sistemul DPS a fost conceput pentru a ajuta la diagnosticarea
problemelor care pot avea ca rezultat inlocuirea nejustificata a unitatilor de disc.

Cand sunt construite aceste sisteme, fiecare unitate de disc instalata este testata utilizadnd sistemul
DPS, iar pe unitate se scrie o inregistrare permanenta cu informatii esentiale. Rezultatele testarii sunt
scrise pe unitatea de disc de fiecare data cand se executa sistemul DPS. Furnizorul de servicii poate
sa utilizeze aceste informatii pentru a determina conditiile care au impus executarea software-ului DPS.

Executarea DPS nu va afecta programele sau datele stocate pe unitatea de disc. Testul apartine de
firmware-ul unitatii de disc si se poate executa chiar daca pe computer nu se incarca un sistem de
operare. Timpul necesar executarii testului depinde de producator si de dimensiunea unitatii de disc; in
majoritatea cazurilor, testul va dura aproximativ doua minute per gigaoctet.

Utilizati DPS cand suspectati o problema legata de unitatea de disc. Cand computerul raporteaza un
mesaj SMART Hard Drive Detect Imminent Failure (Unitatea de disc SMART detecteaza un defect
iminent), nu este necesar sa se execute DPS; in loc de aceasta, faceti o copie de rezerva a informatiilor
de pe unitatea de disc si contactati un furnizor de servicii pentru o Tnlocuire a unitatii de disc.
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Accesarea programului DPS prin Computer Setup

ROWW

Cand computerul nu se alimenteaza corect, utilizati Computer Setup pentru a accesa programul DPS.
Pentru a accesa programul DPS, efectuati urmatorii pasi:

1. Porniti sau reporniti computerul.

2. Cand in coltul din stadnga-jos a ecranului apare mesajul F10 Setup, apasati tasta F10.

Bf NOTA: Daca nu ati apasat tasta F10 in timpul in care este afigat mesajul, trebuie sa opriti
computerul, apoi sa il reporniti, pentru a accesa programul utilitar.

n meniul de programe utilitare Computer Setup, apare o optiune de cinci anteturi: File, Storage,
Security, Power (Fisier — Stocare — Securitate — Alimentare) si Advanced (Avansat).

3. Selectati Storage > DPS Self-Test (Stocare - Testare automata DPS).

Ecranul va afiga lista unitatilor de disc capabile de testarea DPS, care sunt instalate pe computer.

Bf NOTA: Daca nu este instalata nici o unitate de disc capabila de testarea DPS, optiunea DPS
Self-Test (Testare automata DPS) nu va aparea pe ecran.

4. Selectati unitatea de disc care urmeaza sa fie testata si urmati solicitarile de pe ecran, pentru a
finaliza procesul de testare.

Dupa terminarea testului, se va afisa unul dintre urmatoarele trei mesaje:

e Testul a reusit. Cod finalizare 0.

e Testul a fost abandonat. Cod finalizare 1 sau 2.

e  Testul nu a reusit. Se recomanda inlocuirea unitatii. Cod finalizare de la 3 la 14.

Daca testul nu a reusit, codul de finalizare trebuie Tnregistrat si raportat furnizorului de servicii, pentru
ajutor la diagnosticarea problemelor legate de computer.
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